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Preface FIX ME!

This preface includes the following sections: 

• What’s New in This Release

• About This Guide

• Customer Support

The installation instructions in this guide reflect the latest version of 
Synopsys software for each product. Not all products are the same 
version. 

All instructions in this guide are for UNIX systems unless otherwise 
indicated.

Important:   
Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 
xvii



What’s New in This Release

For information about new features and changes in specific 
Synopsys tools, see the individual product documentation. For links 
to Synopsys documentation, see “Related Publications” in the next 
section.

CosmosScope and SaberDesigner   

Because of last-minute changes, installation instructions for 
CosmosScope and SaberDesigner are not included in this 
Installation Guide. For installation instructions for CosmosScope 
version V-2003.12, see the V-2003.12 INSTALL_README.wri file in 
the product download directory or on the product CD. 

For installation instructions for SaberDesigner (or CosmosScope) 
version U-2003.09, see SOLD, version U-2003.09, or the U-2003.09 
version of the Installation Guide at http://www.synopsys.com/
support/Install_Guide.html.
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About This Guide

The Installation Guide provides the basic information and 
procedures required to install Synopsys tools. 

Audience

This guide is written for system administrators responsible for 
installing Synopsys software tools.

Related Publications

For additional information about Synopsys tools, see

• Synopsys Online Documentation (SOLD), which is included with 
the software for CD users or is available to download through the 
Synopsys Electronic Software Transfer (EST) system

• Documentation on the Web, which is available through SolvNet 
at http://solvnet.synopsys.com

• The Synopsys MediaDocs Shop, from which you can order 
printed copies of Synopsys documents, at 
http://mediadocs.synopsys.com
xix



Conventions

The following conventions are used in Synopsys documentation.

Convention Description

Courier Indicates command syntax.

Courier italic Indicates a user-defined value in Synopsys 
syntax, such as object_name. (A user-defined 
value that is not Synopsys syntax, such as a 
user-defined value in a Verilog or VHDL 
statement, is indicated by regular text font 
italic.)

Courier bold Indicates user input—text you type verbatim—
in Synopsys syntax and examples. (User input 
that is not Synopsys syntax, such as a user 
name or password you enter in a GUI, is 
indicated by regular text font bold.)

[ ] Denotes optional parameters, such as 
pin1 [pin2 ... pinN]

| Indicates a choice among alternatives, such as 
low | medium | high
(This example indicates that you can enter one 
of three possible values for an option: 
low, medium, or high.)

_ Connects terms that are read as a single term 
by the system, such as 
set_annotated_delay

Control-c Indicates a keyboard combination, such as 
holding down the Control key and pressing c.

\ Indicates a continuation of a command line.

/ Indicates levels of directory structure.

Edit > Copy Indicates a path to a menu command, such as 
opening the Edit menu and choosing Copy.
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Customer Support

Customer support is available through SolvNet online customer 
support and through contacting the Synopsys Technical Support 
Center.

Accessing SolvNet

SolvNet includes an electronic knowledge base of technical articles 
and answers to frequently asked questions about Synopsys tools. 
SolvNet also gives you access to a wide range of Synopsys online 
services including software downloads, documentation on the Web, 
and “Enter a Call to the Support Center.”

To access SolvNet,

1. Go to the SolvNet Web page at http://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not 
have a Synopsys user name and password, follow the 
instructions to register with SolvNet.)

If you need help using SolvNet, click SolvNet Help in the Support 
Resources section.
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Contacting the Synopsys Technical Support Center

If you have problems, questions, or suggestions, you can contact the 
Synopsys Technical Support Center in the following ways:

• Open a call to your local support center from the Web by going to 
http://solvnet.synopsys.com (Synopsys user name and 
password required), then clicking “Enter a Call to the Support 
Center.”

• Send an e-mail message to your local support center.

- E-mail support_center@synopsys.com from within North 
America. 

- Find other local support center e-mail addresses at 
http://www.synopsys.com/support/support_ctr.

• Telephone your local support center.

- Call (800) 245-8005 from within the continental United States.

- Call (650) 584-4200 from Canada.

- Find other local support center telephone numbers at 
http://www.synopsys.com/support/support_ctr.
xxii
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Preparing for Installation 1

This chapter provides information about steps to complete before 
you install Synopsys tools. 

The chapter contains the following sections:

• Checking Your Hardware and Software Configuration

• Acquiring a License

• Finding Your Site Identification Number

• Creating the Synopsys Root Directory

• Defining the SYNOPSYS Environment Variable
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Checking Your Hardware and Software Configuration

You must check your hardware and software configuration (including 
patch requirements) before you attempt to load any Synopsys tools.

Installation Changes

Beginning with the June, 2003 release of Synopsys software, the 
way the install.now script checks the software version has changed. 
This change affects overlay installation only. 

When you attempt to install overlay software over an earlier release, 
the installation script now looks only at the foundation identifier, for 
example, U or V; it no longer looks for the release month and year. 

For products that allow overlay installation, this change enables you 
to install a later tool version for the same foundation release over an 
earlier tool version. (For example, you could install TetraMAX version 
U-2003.09 over version U-2003.06 of the synthesis tools.)

Do not attempt to install an earlier version of an overlay tool (for 
example, U-2003.06) over a later version of the tool (U-2003.09). 
This installation is not supported, but the install.now script will not 
stop you from doing it if overlay installation is allowed for a product.

Supported Platforms and Operating Systems

Table 1-1 lists the supported platforms, operating systems, and 
corresponding Synopsys platform keywords for this release. Many 
platforms require operating system (OS) patches, including year 
2003 patches. For detailed information, see the Supported Platforms 
Guide page on the Synopsys Web site. Go to
1-2
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http://www.synopsys.com/products/sw_platform.html

and under Supported Platforms Guides, select the appropriate 
foundation for your release.

This Web page provides information about supported hardware, 
operating systems, and required OS patches. If the required patch 
described on this page is not available from the platform vendor, 
install the most recent patch instead.

Table 1-1 Supported Platforms, Operating Systems, and Keywords

Platform Operating system Synopsys platform keywords Window 
environment

HP PA-RISC 2.0 HP-UX 11.0, 11i hp32 (32-bit mode)
hp64 (64-bit mode)

CDE

Sun Sparc Solaris 8, 9  sparcOS5 (32-bit mode)
sparc64 (64-bit mode)

CDE

Intel IA-32 or X86 32 Red Hat Linux 7.2 linux (32-bit mode) GNOME

Intel IA-32 or X86 32 RHEL v31, 3 

1. Red Hat Enterprise Linux (RHEL)

linux  (32-bit mode) GNOME

IPF2 2

2. Itanium Processor Family (Intel Itanium 2 processor)

RHEL v2.11, 3 linuxipf (64-bit mode) GNOME

AMD  Opteron                        RHEL v31, 3 amd64 (64-bit mode)     GNOME

IBM RS6000 AIX 5.13

3. The AIX 5.1 and Linux RHEL platforms are not available on CD. They will be available for download by 
electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales 
representative.

rs6000 (32-bit mode)
aix64 (64-bit mode)

CDE
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HP-UX Requirements

The HP-UX operating system has the following requirements:

• Local (non-NFS) file systems must be configured for long file 
names.

See the /etc/convertfs man page for details.

• The chown privilege must be switched off.

To switch off chown, enter 

% setprivgrp -n chown

See the setprivgrp man page for details. 

Red Hat Linux 7.2 Shared Object File Problem

If you receive an error about libncurses.so.4 (cannot open shared 
object file: no such file or directory) when you run a Synopsys tool on 
a Red Hat 7.2 platform, install the ncurses4 package. This package 
is available on the Red Hat CD, or you can download it from the Red 
Hat FTP server at

ftp://ftp.redhat.com/pub/redhat/linux/7.2/en/os/i386/RedHat/RPMS/
ncurses4-5.0-4.i386.rpm

64-Bit Platform Support

The Synopsys tools support 64-bit operation on HP-UX, Solaris, 
Linux, and AIX platforms. When you run the tools in 64-bit mode, the 
upper limit for virtual address space is extended beyond the 
4-gigabyte limit imposed by the 32-bit mode, allowing you to process 
larger designs. With both the 32-bit and 64-bit platforms installed, 
you have the flexibility to run either 32-bit or 64-bit applications 
without running out of memory. 
1-4
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You can install the 64-bit version of the Synopsys tools in the same 
root directory as the 32-bit version or in a separate directory. When 
both 32-bit and 64-bit dc_shell executable files are installed and you 
specify dc_shell, the first executable file in the PATH environment is 
invoked. 

Note:   
If you attempt to use the 64-bit mode executable file on a 32-bit 
platform, you will see an error message.

Multiple-Platform Installation

When you install tools on a network that connects different platforms, 
the result is the directory tree shown in Figure 1-1.

Figure 1-1 Illustration of a Multiple-Platform Installation

Each Synopsys product includes a platform-independent package 
(indicated by the shaded box in Figure 1-1) containing files common 
to all platforms. When you select multiple platforms, the installation 
script installs one platform-independent package and a 
platform-dependent package for each selected platform.

If you have previously installed a product on one platform and want 
to install it on another platform, 

$SYNOPSYS

admin auxx doc dw interfaces libraries packages platform1 

Platform-independent

platform2
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1. Rerun the installation script for the product.

2. In the installation script,

- Answer n to the query about installing the 
platform-independent package.

- Specify the new platform when queried about which platform 
to install.

Products and Platforms

Table 1-2 lists the products and their supported platforms. For the 
latest product-specific platform information, see the release notes for 
your tool. 

Table 1-2 Products and Supported Platforms 

Product Product ID Platform keyword

AMPS amps sparcOS5, hp32, linux

Arcadia arc sparcOS5, sparc64, hp32,  
hp64, rs6000

Cadabra cadabra sparcOS5, hp32, linux

Floorplan Compiler fpc sparcOS5, sparc64, linux

Formality fm sparcOS5, sparc64, hp32,  
hp64, rs6000, linux, linuxipf 

FPGA Compiler II fc2 sparcOS5, hp32, Windows

NanoSim (including ADFMI,
    NanoSim Integration with
    VCS, CosmosScope, 
turboWave, Verilog-A,
    and VTRAN)

ns sparcOS5, sparc64, hp32,  
hp64, rs6000, linux, linuxipf
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PathMill pm sparcOS5, sparc64, hp32,  
hp64, linux, linuxipf,  rs6000

PowerMill (including ADFMI,
    VTRAN, and turboWave)

pw sparcOS5, sparc64, hp32, 
hp64, rs6000

PrimePower pps sparcOS5, sparc64, hp32, 
hp64, linux

PrimeTime pts sparcOS5, sparc64, hp32, 
hp64, linux, linuxipf, rs6000

RailMill rm sparcOS5, sparc64, hp32,  
hp64, rs6000

Synthesis syn sparcOS5, sparc64, hp32,  
hp64, rs6000, linux, linuxipf 

SYSTEMSIM, SYSTEMEX systemsim
systemex

sparcOS5, linux

System Studio css sparcOS5, hp32, linux 
gccsparcOS5 

TetraMAX tx/txs sparcOS5, sparc64, hp32, 
hp64, linux, linuxipf

TimeMill (including ADFMI,
    VTRAN, and turboWave)

tm sparcOS5, sparc64, hp32, 
hp64, rs6000

VCS vcs, vcsi sparcOS5, sparc64,
hp11.0 PA2.0_32, 64, linux, 
AIX 32, 
dec_alpha_osfl_4.0_64, 

Vera vera sparcOS5, sparc64, hp32, 
linux, rs6000

VHDL Simulation (Scirocco) scirocco sparcOS5, hpux10, linux, 
rs6000

Table 1-2 Products and Supported Platforms (Continued)

Product Product ID Platform keyword
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Note:   
Products that support the AIX 4.3.3 (rs6000) and  Linux Intel 
Itanium platforms will be available by EST at a later date. For 
more information, contact your local applications consultant.

Disk Space Requirements

Table 1-3 lists the amount of disk space required to install the various 
Synopsys tools. Each CD also includes this information in the 
top-level README.product_name file.

Table 1-3 Disk Space Requirements 

Synopsys product Required size in MB (approximate)

AMPS 
Platform independent
Per platform

35
110

Arcadia
Platform independent
Per platform

40
450

Cadabra
       Platform independent

Per platform
140
75

Floorplan Compiler
Platform independent
Per platform

50
400

Formality
Platform independent
Per platform

102
132

FPGA Compiler II
Platform independent
Per platform

150
100
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NanoSim 
Platform independent
Per platform

50
500

PathMill 
Platform independent
Per platform

11
172

PowerMill 
Platform independent
Per platform
sparcOS5

50
300
450

PrimePower
Platform independent
Per platform

492
122

PrimeTime 
Platform independent
Per platform

450
350

RailMill
Platform independent
Per platform

125
300

Synthesis tools 
Platform independent
Per platform

400 
825

Synopsys online documentation 
(English)

385 

Synopsys online documentation 
(Japanese)

350 

System Studio
Platform independent
Per platform

700
600

System Studio SOLD 100

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
1-9

Preparing for Installation



Memory Requirements

The UNIX kernel defines hard per-process limits on the maximum 
amount of memory that can be used, and the limit command 
creates soft limits. If ignored, these limits can cause processes (jobs) 
to fail even when sufficient memory is available. For more 
information, see “Memory” on page 24-2.

TetraMAX (overlay)
Platform independent
Per platform

9
40

TetraMAX (stand-alone)
Platform independent
Per platform

9
112

TimeMill 
Platform independent
Per platform

       sparcOS5

50
300 
450

VCS
Per platform 400

Vera
Per platform 400

VHDL Simulation (Scirocco)
Platform independent
Per platform

320
500

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
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Table 1-4 lists the general guidelines for the minimum amount of 
physical memory and swap space (virtual memory) required to run 
Synopsys tools.  

Table 1-4 Minimum Memory Requirements 

Tool Physical memory (MB) Swap space (MB)

AMPS 256 
Recommended: 1GB

512
Recommended: 2GB

Arcadia 256 512

Cadabra 1 GB 256

Floorplan Compiler 256 512

Formality1 256 512

FPGA Compiler II 64 140

NanoSim 256
Recommended: 1GB

512
Recommended: 2GB

PathMill 256
Recommended: 1GB

512
Recommended: 2GB

PowerMill 256
Recommended: 1GB

512
Recommended: 2GB

PrimePower 128 256

PrimeTime 150 256

RailMill 256 512

Synthesis tools 128 256 

System Studio 256 512

TetraMAX2 256 512 

TimeMill 256
Recommended: 1GB

512
Recommended: 2GB
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Physical Memory Requirements for Synthesis, 
PrimeTime, and Design Budgeting 

For the synthesis, PrimeTime, or design budgeting tools to run 
efficiently, the physical memory must equal 25 to 50 percent of the 
swap space. For example, if you have 128 MB of swap space, you 
need at least 32 MB of physical memory. You might need as much as 
64 MB, however. The more physical memory you have, the more 
quickly your job runs.

Swap Space Requirements for Synthesis Tools 

The amount of swap space required by the synthesis tools depends 
on the size and type of each circuit design.

Use the following formula to help you determine the minimum 
amount of available swap space required for HDL designs: 
16.3 MB + (5.9 x (size of the design in K gates)).

VCS 256
Recommended: 2 GB

768

Vera 256
Recommended: 1GB

512
Recommended: 2GB

VHDL Simulation (Scirocco) 256
Recommended: 1GB

512
Recommended: 2GB

1. For large designs, the expected amount of required memory is approximately 1 million bytes 
per 2,000 gates. 
2. Physical memory and swap space requirements are dependent on design size. For the 
figures in the table, it is assumed that the design size is less than 1 million (equivalent NAND) 
gates.

Table 1-4 Minimum Memory Requirements (Continued)

Tool Physical memory (MB) Swap space (MB)
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For example, a 5K-gate design requires 16.3 + (5.9 x 5) = 45.8 MB 
of available swap space.

Accessing Memory Beyond 2 GB With 32-Bit 
Synopsys Tools

In general, UNIX-based systems support a maximum memory of 2 
GB for 32-bit processes. However, the following Synopsys tools can 
extend memory beyond 2 GB:

• Design Compiler

• DFT Compiler

• Floorplan Compiler

• Floorplan Manager

• Formality

• HDL Compiler (Presto Verilog)

• NanoSim

• Physical Compiler

• Power Compiler

• PowerMill

• PrimePower

• PrimeTime

• RailMill

• TimeMill

• VCS
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• Vera

• VHDL Simulation (Scirocco)

Note:   

Available memory is space not used by the OS, the windowing 
system, or other applications.

To access memory beyond 2 GB,

1. Do one of the following, depending on the platform you are using:

- For HP-UX,

Make sure your server has HP-UX 11.0 (or later) loaded.

- For Solaris,

Make sure your server has Solaris 8 (or later) loaded.

2. Make sure your server has at least 4 GB of memory (physical and 
swap space) available.

Note:   

Physical memory equals data size plus stack size, and stack 
size is used before data size. Therefore setting stack size to a 
large value causes problems for designs that need to go over 
2 GB. If you set the stack size too high, you cannot get enough 
memory for your data. To check the settings, use the limit 
command at the system prompt. For more information, see 
“Memory” on page 24-2.

3. Make sure the system you are using does not have restrictions 
that prevent you from using more than 2 GB of memory.
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4. Create unlimited data size in the shell that you are using: C, 
Bourne, Korn, or Bash. If there are systemwide limits on the data 
size you can create, you can remove them or override them. You 
can do this in one of two ways:

- Enter one of the following commands:

For the C shell,

% limit datasize 3800000 

For the Bourne, Korn, or Bash shell,

# ulimit -S -d 3800000 

- Modify the kernel of your server. This approach allows 
everyone using your server to extend memory beyond 2 GB.

Note:   

On HP-UX systems, you will see a data size of 2 GB. This 
value is accurate. After your process reaches the 2-GB limit, 
the Synopsys product extends the address space.

Acquiring a License

The Synopsys Common Licensing (SCL) system provides a single, 
common licensing base for all Synopsys tools. The SCL software 
and the documentation describing how to install and configure it are 
separate from the tools that use it. 

Before you can use the Synopsys tools, you must do the following:

• If you have not already done so, retrieve your license keys from 
the SmartKeys Web page at 
http://solvnet.synopsys.com/smartkeys.
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• Install the SCL software. 

Note:   

Installation of Synopsys tools and SCL is not order dependent. 
You can install SCL before or after you install your Synopsys 
tools. However, you cannot use your Synopsys tools until you 
have installed, configured, and started SCL. 

Obtaining Your License Keys 

To obtain your license key file from SmartKeys,

1. Go to the SmartKeys Web page at 

http://www.synopsys.com/smartkeys

2. On the SmartKeys Web page, click Key Retrieval.

3. In the Key Retrieval box, enter the following information:

- Your site ID. This is the numeric site ID that identifies your 
customer site. If you have synthesis, test, or VHDL simulation 
tools installed, you can obtain the site ID by viewing your 
site_info file: $SYNOPSYS/admin/license/site_info. 

- Your host ID (optional). To obtain a license key file for a single 
host, enter its host ID. To obtain license keys for all hosts at the 
specified site, leave this field blank.

- Your e-mail address. The default is your Synopsys e-mail 
address. This is the address that your key file will be sent to.

4. Click Continue to submit your request.
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Installing Synopsys Common Licensing Software

You need to install, configure, and start a single copy of SCL 
software for all Synopsys tools. If you don’t have the SCL software, 
you can download it by EST or FTP: See the 
http://www.synopsys.com/keys/#download_SCL Web page.

Alternatively you can order the SCL software CD from the Synopsys 
MediaDocs Shop at http://mediadocs.synopsys.com.

If you already have SCL running, you do not need to reinstall it. 
However, if you are updating your license key file, you need to notify 
the SCL daemons that the license file has changed. See the SCL 
documentation for instructions on this process.

Note:   
Do not install SCL into an existing directory. You must install SCL 
into a stand-alone directory.

For more information about licensing, see the following documents:

• Synopsys Common Licensing Quick Start

• Synopsys Common Licensing Installation and Administration 
Guide

Soft copies of the Synopsys Common Licensing Quick Start 
document and the Synopsys Common Licensing Installation and 
Administration Guide are available in Portable Document Format 
(PDF) from http://www.synopsys.com/keys/#Info_SCL.
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Finding Your Site Identification Number

Before you install any Synopsys product CD, locate and make a note 
of your Synopsys site identification number. Enter your site ID when 
prompted during the installation process.

Your site ID was shipped in the package with your Synopsys tools, or 
if you download the software, it is in your Synopsys Order 
Notification e-mail. If you have trouble locating it, contact your 
Synopsys sales representative. 

Creating the Synopsys Root Directory

To create a new directory tree for this Synopsys release, enter

% mkdir -p /usr/synopsys/product_version

To set the permissions on the new directory tree, enter 

% chmod 755 /usr/synopsys/product_version

Important:   
Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 
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Defining the SYNOPSYS Environment Variable

Set the SYNOPSYS environment variable ($SYNOPSYS) in the shell 
that you are using: C, Bourne, Korn, or Bash. In the following 
examples, the root_directory argument is the name of the 
Synopsys root directory.

If you are using the C shell, enter the following command to set the 
SYNOPSYS environment variable:

% setenv SYNOPSYS root_directory

If you are using the Bourne, Korn, or Bash shell, enter the following 
command to set the SYNOPSYS environment variable:

# SYNOPSYS=root_directory; export SYNOPSYS
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2
Downloading and Installing the Software 2

This chapter provides information about downloading and installing 
Synopsys tools.

The chapter contains the following sections:

• Downloading and Installing the Software by EST

• Performing EST Installation

• Installing Product Files From a CD
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Downloading and Installing the Software by EST

You can download Synopsys software in two ways:

• By FTP

• From the Web

For help with download problems, contact the Synopsys Electronic 
Software Transfer department:

E-mail support: est-adm@synopsys.com 
Telephone support: 650-584-1631

Note:   
The EST department does not help with installation or licensing 
issues. For help with such issues, contact your local Support 
Center.

To access the online EST Troubleshooting Guide, go to 
http://www.synopsys.com/cgi-bin/est.cgi.

Caution!   
 Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 

Using the Product Files

Depending on file size, product files are packaged by one of three 
processes, tar, tar.Z, or tar.gz. These instructions cover each 
process.

The product files use the following naming convention:
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For .tar files

productname_productversion_common.tar
productname_productversion_platform.tar

For tar.Z files

productname_productversion_common.tar.Z
productname_productversion_platform.tar.Z

For tar.gz files

productname_productversion_common.tar.gz
productname_productversion_platform.tar.gz

For each tool you want to install, substitute the appropriate product 
ID and version for productname_productversion and platform 
keyword for platform. (See “Products and Platforms” on page 1-6.)

Important:   
For each product except SOLD, you must install one common file 
(platform-independent package) and one or more 
platform-specific files. (See Figure 1-1 on page 1-5.) For SOLD, 
install only the tar files. (SOLD version U-2003.09 does not have 
a common file and is platform independent.)
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Downloading the Files by FTP

To download the files by FTP,

1. For each tool, you must create a separate empty directory to 
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Start an FTP session to ftp.synopsys.com.

% ftp ftp.synopsys.com

3. Enter your SolvNet user name and password.

4. At the ftp prompt, enter the following commands:

ftp> binary
ftp> cd rev
ftp> cd productname_productversion
ftp> get productname_productversion_common.tar
ftp> get productname_productversion_platform.tar

For a list of supported platforms and products for this release, 
see Table 1-2 on page 1-6.

5. Download the files into the directory you just created.

6. For installation instructions, see “Performing EST Installation” on 
page 2-6. 
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Downloading the Files From the Web

To download files from the Web,

1. For each tool, you must create a separate temporary directory to 
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Go to the Electronic Software Transfer (EST) Web page at

http://www.synopsys.com/cgi-bin/est.cgi

3. Click the Authenticated Access button.

4. Enter your SolvNet user name and password.

5. Read the legal page and, if you agree, click “Yes, I agree to the 
above terms.”

6. Click the rev folder.

7. Click the file folder for the product and version you want to install.

8. Download the files into the temporary directory.

Note:   

For each product, you must download one common file 
(platform-independent package) and one or more 
platform-specific files. 

9. For installation instructions, see “Performing EST Installation,” 
next.
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Performing EST Installation

To install the software,

1. Untar the .tar files, or untar and uncompress the tar.Z or tar.gz 
files. For example, 

For tar files

% tar xvf productname_productversion_common.tar
% tar xvf productname_productversion_platform.tar

For tar.Z files

    % cat productname_productversion_common.tar.Z | uncompress | tar  xvf - 
  % cat productname_productversion_platform.tar.Z | uncompress | \

tar xvf - 

or

    % zcat productname_productversion_common.tar.Z | tar xvf - 
    % zcat productname__productversion_platform.tar.Z | tar xvf - 

For tar.gz files

    % gzip -dc productname_productversion_common.tar.gz | tar xvf - 
    % gzip -dc productname_productversion_platform.tar.gz | tar xvf - 

If you want to perform this process in two steps, do the following:

% gzip -d productname_productversion_common.tar.gz 
% tar xvf productname_productversion_common.tar

% gzip -d productname_productversion_platform.tar.gz 
% tar xvf productname_productversion_platform.tar

Substitute the appropriate product ID and version for 
productname_productversion and the platform keyword for 
platform. (See “Products and Platforms” on page 1-6.)
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Note:   

If you don’t want to see the list of unpacked files, omit the v 
from xvf -. 

2. Execute the following command to install the software:

% ./install.now 

To install Synopsys tools, it is recommended that you log on as 
root or have system administrator privileges. You need write 
permission for the installation directory.

3. Answer the installation program prompts.

Important:   

When you are prompted to choose a location for installing the 
software, do not select the /tmp directory. You must specify a 
new directory. Do not install different versions of Synopsys 
software in the same directory. 

Repeat steps 1 through 3 for each tool you want to install. 

Installing Product Files From a CD

Use the same installation procedure to transfer the files from each 
CD (or CD set) to your system.

To install a CD,

1. Mount the CD.

2. Run the installation script.

3. Unmount the CD.
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Complete information about these steps is given in the following 
sections.

Mounting the CD

Mounting the CD might require root access privileges. If you do not 
have root access privileges, see your system administrator for 
instructions on mounting the CD. If you have the proper privileges, 
complete the following steps.

To mount the CD,

1. Place the CD in the CD drive.

2. Create a CD directory. For example, enter

% mkdir /cdrom

3. Mount the CD by using the appropriate command for your 
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:   
Mounting instructions are different for each platform. See your 
system administrator for the correct CD mounting commands.

Also, for sparcOS5 with vold (the volume management daemon 
for managing CD and floppy devices), the /cdrom directory 
already exists and the CD is automatically mounted. Therefore, 
use cd /cdrom/cdrom0 instead of cd /cdrom (and use eject to 
unmount the CD). 
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Installing the Software From the CD 

The following steps apply only to tools that use the standard 
installation. For CD installation of FPGA Compiler II, see “Installing 
the Software” on page 9-3. 

To install the software,

1. Move to the CD-ROM directory. For example, enter

% cd /cdrom

2. View the README.1ST file on the CD for more information. View 
the README.productname file for the most up-to-date disk 
space requirements.

3. Enter the installation command.

% ./install.now

4. Answer the installation program prompts.

If you receive an UNCOMPRESS/TAR ERROR during the 
installation script, rerun the installation command, using the 
-i option to correct the problem. For example, enter

% ./install.now -i

Example 2-1 shows a sample Synopsys media installation script for  
the synthesis tools on the Sun Solaris platform; it applies to 
installation by EST and from the CD. Other tools are installed in a 
similar manner. 
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Note:   
To perform an overlay installation for TetraMAX, enter tx for 
TetraMAX when you are prompted to select the product you want 
to install. To perform a stand-alone installation, enter txs for 
TetraMAX stand-alone. 

Example 2-1 Synopsys Media Installation Script for the Synthesis Tools

                   Synopsys Media Installation

Instructions:  The list within {} shows the choices for a given option.
               The entry within [] shows the default selection when you
               hit the Return key. You can cancel the installation by
               by entering quit when prompted for input.

___________________________________________________________________________

The current mounted Synopsys CD file system is V-2003.12.

        VERSION:      V-2003.12
        PRODUCTS:     syn sf3 sf4 
        PLATFORMS:    sparcOS5 
        PART NUMBER:  XXXXXX

___________________________________________________________________________

Install V-2003.12 release? {y,n} [y] y

Enter the full path to the directory where you want to install
Synopsys V-2003.12_syn products. If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/syn_V-2003.12
Creating Synopsys root directory /usr/synopsys/syn_V-2003.12...

Select Synopsys product(s) to install:
        {
        syn - Core Synthesis Tools
        sf3 - Synopsys Integrator for Falcon Framework MentorC
          sf4 - Synopsys Integrator for Falcon Framework MentorD
        }
Enter the list of product(s) to install [syn sf3]: syn sf3 

Product(s) selected: syn sf3 

Platform Independent Package for a particular product contains 
support files that are common to all the platforms. 
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You must install this package for each product if you 
are installing it to the /usr/synopsys/syn_V-2003.12 
directory for the first time. 

Install Platform Independent Package for syn? {y,n} [y]: y

Install Platform Independent Package for sf3? {y,n} [y]: y
sparcos5

Verify cksum for ./syn.taz ...Pass.
Verify cksum for ./sparcos5/syn.taz ...Pass.
Verify cksum for ./sf3.taz ...Pass.
Verify cksum for ./sparcos5/sf3.taz ...Pass.

Platform(s) selected: sparcos5
___________________________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   V-2003.12
    PRODUCTS:  syn sf3 
    PLATFORMS: sparcos5

    Synopsys Media Directory (from) : /cdrom
    Synopsys Install Directory (to) : /usr/synopsys/syn_V-2003.12

    Platform Independent Package(s) for : syn sf3 

    Disk space required             : 1034 MB
    Disk space available            : 14649 MB

If all the information is correct, continue with the installation.

___________________________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING syn product, platform_independent package, V-2003.12 version.
  uncompress < ./syn.taz | (cd /usr/synopsys/syn_V-2003.12; tar xvfp - )
sparcos5
INSTALLING syn product, sparcos5 package, V-2003.12 version.
uncompress < ./sparcos5/syn.taz | (cd /usr/synopsys/syn_V-2003.12; tar xvfp - )

INSTALLING sf3 product, platform_independent package, V-2003.12 version.
  uncompress < ./sf3.taz | ( cd /usr/synopsys/syn_V-2003.12; tar xvfp - )
sparcos5
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INSTALLING sf3 product, sparcos5 package, V-2003.12 version.
  uncompress < ./sparcos5/sf3.taz | (cd /usr/synopsys/syn_V-2003.12; tar xvfp - )

Installing Design Compiler ...

Installing Module Compiler ...

Installing Library Compiler ...

Installing Physical Compiler ...
Setting up environment for Astro ...

Installing Synopsys Integrator for Falcon Framework version C
 
 
Synopsys Site Identification Number appears on the upper right corner
of your Synopsys License Key Certificate.

Synopsys Site Identification Number [Hit return for 000]: 000 

Synopsys License Administrator is a person who must be contacted
for Synopsys product related administrative tasks at your site.

Local Synopsys License Administrator [Hit return for customer]: 

License Administrator Contact is the current phone number and/or
Email address of customer.

License Administrator Contact [Hit return for ###-#### and/or user@email]: 

Created site file /usr/synopsys/syn_V-2003.12/admin/license/site_info.

Installation is complete. 

To use this software, you must be running the Synopsys Common Licensing
(SCL) version 8.4 daemon (snpslmd) on your license server. For more
information on SCL 8.4, see the Synopsys Licensing QuickStart Guide at
http//www.synopsys.com/keys.
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For any post-installation setup requirements, see the product-specific chapters 
in the Installation Guide at
http://www.synopsys.com/support/Install_Guide.html. 

Thank you ...

Example 2-2 shows a sample Synopsys media installation script for 
version V-2003.12 of the PrimeTime tools; it applies to installation by 
EST and from the CD. Other version V-2003.12 tools are installed in 
a similar manner. 

Example 2-2 Synopsys Media Installation Script for PrimeTime
Synopsys Media Installation

Instructions:  The list within {} shows the choices for a given option. The entry 
within [] shows the default selection when you hit the Return key.  You can 
cancel the installation by entering quit when prompted for input.
_________________________________________________________

The current mounted Synopsys CD file system is V-2003.12.

        VERSION:     V-2003.12
        PRODUCTS:    pts
        PLATFORMS:   sparcOS5 sparc64 
        PART NUMBER: XXXXXX

_________________________________________________________
Install V-2003.12 release? {y,n} [y] y

NOTE:  The product(s) pts on this CD-ROM must be installed in a
       stand-alone directory.

Enter the full path to the directory where you want to install
Synopsys V-2003.12_pts products. If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/pts_V-2003.12

Creating Synopsys root directory /usr/synopsys/pts_V-2003.12...

Product(s) selected: pts

The Platform Independent Package for a particular product contains support files 
that are common to all the platforms. 
You must install this package for each product if you are installing it to the 
/usr/synopsys/pts_V-2003.12 directory for the first time. 
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Install Platform Independent Package for pts? {y,n} [y]: y

Select platform(s) to install:
        {
        sparcOS5 (for Solaris 8, 9)
        sparc64  (for Solaris 8, 9; 64-bit) 
        }
Enter the list of platform(s) to install [sparcOS5]: sparcOS
Platform(s) selected: sparcos5
__________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   V-2003.12
    PRODUCTS:  pts
    PLATFORMS: sparcos5

    Synopsys Media Directory (from) : /cdrom
       Synopsys Install Directory (to) : /usr/synopsys/pts_V-2003.12

    Platform Independent Package(s) for : pts

    Disk space required             : 290 MB
    Disk space available            : 10063 MB

If all the information is correct, continue with the installation.

_________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING pts product, platform_independent package, V-2003.12 version. 
uncompress < ./pts.taz | ( cd /usr/synopsys/pts_V-2003.12; tar xvfp - ) sparcos5
INSTALLING pts product, sparcos5 package, V-2003.12 version.
  uncompress < ./sparcos5/pts.taz | (cd /usr/synopsys/pts_V-2003.12; tar xvfp - )

Installing PrimeTime ...

Synopsys Site Identification Number appears on the upper right corner of your 
Synopsys License Key Certificate.

Synopsys Site Identification Number [Hit return for 000]: 
000
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Synopsys License Administrator is a person who must be contacted for Synopsys 
product related administrative tasks at your site.

Local Synopsys License Administrator [Hit return for customer]: 

License Administrator Contact is the current phone number and/or Email address 
of customer.

License Administrator Contact [Hit return for ###-#### and/or user@email]: 

Created site file /usr/synopsys/pts_V-2003.12/admin/license/site_info.

Installation is complete.

To use this software, you must be running the Synopsys Common Licensing
(SCL) version 8.4 daemon (snpslmd) on your license server. For more
information on SCL 8.4, see the Synopsys Licensing QuickStart Guide at
http//www.synopsys.com/keys.

For any post-installation setup requirements, see the product-specific chapters 
in the Installation Guide at
http://www.synopsys.com/support/Install_Guide.html. 

Thank you ...

Unmounting the CD

To unmount the CD,

1. Move to another directory. For example, enter

% cd /tmp

2. Unmount the CD by using the appropriate command for your 
operating system. For example, enter

% umount /cdrom

Note:   

If you are running the volume management daemon, use the 
eject command to unmount the CD.

3. Remove the CD from the drive.
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Note:   
To run the Synopsys tools, Synopsys Common Licensing (SCL) 
software must be installed. For details about Synopsys licensing 
software, see the Licensing Quick Start document and the 
Licensing Installation and Administration Guide, which are 
available online at www.synopsys.com/keys.
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3
Installing the Synopsys Synthesis Tools 
(version V-2003.12) 3

This chapter contains the following sections:

• Synthesis Tools

• Installing the Software

• Configuring the Synthesis Tools

• Installing Optional Tools

• Verifying the Synthesis Tools Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).
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• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Synthesis Tools

The Synopsys synthesis tools include the following:

• Core synthesis tools

- Automated Chip Synthesis

- BSD Compiler

- Behavioral Compiler

- Design Analyzer

- Design Compiler

- Design Vision

- DesignWare 

- DFT Compiler

- EDIF 2 0 0 Interface

- Floorplan Manager

- HDL Compiler (Presto Verilog)

- Library Compiler

- Module Compiler
3-2

Installing the Synopsys Synthesis Tools (version V-2003.12)



- Physical Compiler

- Power Compiler

- SystemC Compiler

- VHDL Compiler

• Synopsys Integrator for Falcon Framework

- Mentor C version

- Mentor D version

If you have purchased any of these tools, you must install the 
synthesis tools suite. 

Most synthesis tools install on all platforms (sparcOS5, sparc64, 
hp32, hp64, linux, and rs6000). The exceptions are noted in 
Table 3-1. 

Table 3-1 Synthesis Tools That Do Not Install on All Platforms

sparcOS5 hp32 linux rs6000 gccsparcOS5

Behavioral Compiler x x x x

SystemC Compiler x x x x

Design Analyzer x x x x
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Installing the Software 

To download and install the synthesis tools from the Web or by FTP, 
follow the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To transfer the files from the Synthesis CD to your system, follow the 
installation procedure described in “Installing Product Files From a 
CD” on page 2-7.

On the sparcOS5 platform, you can choose to install either version 
C (sf3) or D (sf4) of the Synopsys Integrator for Falcon Framework 
product, but not both. On the hp32 platform, you can install only 
version D (sf4).

Example 2-1 on page 2-10 shows a sample Synopsys media 
installation script for the synthesis tools.

Configuring the Synthesis Tools

This section describes how to

• Set up the synthesis tools for each user

• Set up the systemwide defaults 

• Set up SystemC Compiler for Each User

• Configure the Browser for Physical Compiler and Design Vision 
Online Help
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Setting Up the Synthesis Tools for Each User

To set up a new synthesis tools user,

1. Add the directory for the synthesis executable files to the PATH 
environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

When you install the synthesis files, a copy of the synthesis setup 
file is placed in $SYNOPSYS/admin/setup/.synopsys_dc.setup.  
The .synopsys_dc.setup file contains the system defaults for the 
synthesis tools. You can modify this file to customize the settings 
for your environment.

2. Place a .synopsys_dc.setup file in the user’s home directory.

If you are using the C shell, enter

        % cp $SYNOPSYS/admin/setup/.synopsys_dc.setup ~/.synopsys_dc.setup

If you are using the Bourne, Korn, or Bash shell, enter

       # cp $SYNOPSYS/admin/setup/.synopsys_dc.setup $HOME/.synopsys_dc.setup

You can modify this file to customize the settings for each user.
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3. To use a graphical user interface (GUI), such as Design Analyzer, 
you must also add the X Window System executable files to the 
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=(/usr/dt/bin /usr/bin/X11 $path)

For Solaris 8 or 9, add

set path=(/usr/dt/bin /usr/openwin/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=/usr/dt/bin:/usr/bin/X11:$PATH
export PATH

For Solaris 8 or 9, add

PATH=/usr/dt/bin:/usr/openwin/bin/X11:$PATH
export PATH
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Setting Up the Systemwide Defaults

If you are using the Design Analyzer product, you can customize the 
display for all users at a site by modifying the Design Analyzer 
application defaults (app-defaults) file. This file is placed in the 
following location during installation:

$SYNOPSYS/admin/setup/Design_analyzer

To see a list of available colors for the Solaris 7 and 8 platforms,  
enter

% more /usr/openwin/lib/X11/rgb.txt

For all other platforms, enter

% more /usr/lib/X11/rgb.txt

To see a list of available fonts, enter

% xlsfonts | more

To install the changes, copy the modified app-defaults file into the 
systemwide app-defaults location, which varies from site to site. To 
find the systemwide location at your site, contact your system 
administrator.

Note:   
You must have root access privileges to install this systemwide 
defaults file.

If your app-defaults location is in X11 (a common location), install the 
Design_analyzer file by entering a command similar to the one in the 
following example:
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% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/openwin/lib/X11/app-defaults

% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/lib/X11/app-defaults

You can customize the GUI display for an individual Design Analyzer 
user by adding color and font definitions to the .Xdefaults file in each 
user’s login directory. Values defined in the .Xdefaults file override 
the values in the systemwide app-defaults file.

If you are using the Design Vision or Physical Compiler GUI tools, 
see the appropriate online Help system for information about 
customizing the tool environment.

Setting up SystemC Compiler for Each User

To set up a SystemC Compiler user, in addition to the other synthesis 
settings, you must define the absolute path to a C++ compiler and 
the compiler options.

If you are using the C shell, add the following lines to the .cshrc file:

setenv SYSTEMC_CPP "compiler_home options"

If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile, .kshrc, or .bashrc file:

SYSTEMC_CPP=compiler_home options
export SYSTEMC_CPP

For the GNU C++ Compiler version 2.95.2 or later (or version 3.2 for 
Linux), replace compiler_home with the absolute path to the GNU 
C++ Compiler, and replace options with the typical compiler options 
you use. For example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C"
3-8

Installing the Synopsys Synthesis Tools (version V-2003.12)



For the Sun SparcWorks C++ Compiler (version 5.0 or later), replace 
compiler_home with the absolute path to Sun SparcWorks C++ 
Compiler, and replace options with the typical compiler options you 
use. For example,

setenv SYSTEMC_CPP "/usr/local/bin/cc -E -xCC -Xc"

The SystemC Compiler default path to the SystemC library include 
files is $SYNOPSYS/auxx/systemc/include. To define a different 
path to the SystemC library include files, specify the -I option for 
SYSTEMC_CPP. For example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C -I /my_systemc/
include"

Configuring the Browser for Physical Compiler and 
Design Vision Online Help

The Physical Compiler and Design Vision online Help systems are 
browser-based HTML Help systems. For optimal viewing, use 
Netscape Navigator version 4.78 for UNIX. These Help systems are 
not supported in Netscape Navigator version 6 or later.

Important:   
When you use online Help from within the GUI, the Netscape 
executable file must be on the UNIX path.

Both Help systems make extensive use of Java applets, JavaScript, 
and style sheets. In your browser preferences, select the Advanced 
category and make sure that 

• The Enable Java, Enable JavaScript, and Enable Style Sheets 
options are all selected

• The Enable Java Plugin option is deselected
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You can open either Help system from within its respective GUI tool 
or open it stand-alone in Netscape Navigator. 

Installing Optional Tools

The synthesis media installation script automatically installs most of 
the synthesis tools. However, the following tools require manual 
setup or installations:

• Synopsys Integrator for Falcon Framework

• Power Compiler VPOWER

• SoCBIST

Installing Synopsys Integrator for Falcon Framework

To complete the setup for the Synopsys Integrator for Falcon 
Framework product, set the SYNOPSYS_IFF_ROOT environment 
variable to point to the Synopsys integrator directory.

When asked for the Falcon Framework version, enter

• C if you selected the sf3 product from the installation script

• D if you selected the sf4 product from the installation script

Note:   

You can install Falcon Framework version C or D, but not both. 
Version C is supported only on the Solaris 8 (sparcOS5) 
operating system; version D is supported on both 
HP-UX 11.0 or 11i (hp32) and Solaris 8 (sparcOS5) operating 
systems.
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If you are using the C shell, add the following line to the .cshrc file:

setenv SYNOPSYS_IFF_ROOT $SYNOPSYS/platform/syn/interfaces/mentorC

If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile file:

SYNOPSYS_IFF_ROOT=$SYNOPSYS/platform/syn/interfaces/mentorC 
export SYNOPSYS_IFF_ROOT

Replace platform with one of the following: hp32 or sparcOS5.

Installing Power Compiler VPOWER

VPOWER is the Power Compiler interface to VCS, the Cadence 
Verilog-XL and NC-Verilog simulators, and the MTI Verilog simulator. 
VPOWER contains user tasks that allow you to monitor toggle 
activity during simulation and to output the information in a form 
readable by Power Compiler. To use VPOWER, link the user tasks to 
the executable file of your simulator. 

The following sections describe the steps for static-linking VPOWER 
with Verilog-XL and VCS simulators only. For information about 
linking VPOWER with other simulators, see the Power Compiler 
User Guide. 

Verilog-XL Simulator

The following procedure describes how to link VPOWER to a version 
of the Verilog-XL simulator that contains the standard features you 
normally use at your site and includes the toggle count utilities 
needed for Power Compiler.
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Note:   
You must perform this installation on a machine that has access 
to your Verilog-XL simulator vendor distribution.

Consult your Verilog system administrator to obtain the following 
information before beginning the VPOWER installation:

• The directory path to your Verilog .o, .a, and .h files

• The directory location of your central Verilog distribution, for 
obtaining a current site copy of the veriuser.c file

This installation requires modification of your veriuser.c file. By 
obtaining a current site copy of the veriuser.c file, you can be sure to 
include any current site modifications when you modify this file.

To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of your site veriuser.c file.

3. Link the VPOWER user tasks to the simulation executable file.

4. Copy the linked executable file.

The following sections describe these steps.
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Changing to the Synopsys power Directory. All directories listed 
are relative to the root of the vpower directory: $SYNOPSYS/auxx/
syn/power/vpower.

To change to the Synopsys vpower directory,

1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the veriuser.c File. To modify the veriuser.c file to define 
the new toggle count utilities,

1. Change to the vxl/vxl.sample directory, and review the sample 
veriuser.c file, which shows the edits you will have to make.

% cd vxl/vxl.sample

2. Copy your current site version of veriuser.c into the sample 
directory. To copy veriuser.c, you must know the directory 
location of your central Verilog distribution.

% cp site_location_dir_path/veriuser.c .

By using a current site copy of veriuser.c, you ensure that any 
existing customizations are included in the VPOWER installation.

3. As shown in the sample veriuser.c file, make the following 
changes in your current site copy of veriuser.c:
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- Add the following line:

# include "tc_extern.h"

- Add the following user tasks:

{usertask, 0, 0, 0, tc_set, tc_set_sync, "$toggle_set", 1},
{usertask, 0, 0, 0, tc_start, 0, "$toggle_start", 1},
{usertask, 0, 0, 0, tc_stop, 0, "$toggle_stop", 1},
{usertask, 0, 0, 0, tc_reset, 0, "$toggle_reset", 1},
{usertask, 0, 0, 0, tc_compatibility, 0, "$toggle_count", 1},
{usertask, 0, toggle_report_check, 0, toggle_report, 0, "$toggle_report", 0},
{usertask, 0, 0, 0, read_lib_saif, tc_lib_sync, "$read_lib_saif", 1},
{usertask, 0, 0, 0, read_rtl_saif, tc_set_sync, "$read_rtl_saif", 1},

- Comment out the following line:

char *veriuser_version_str = "";

4. Save your modified veriuser.c file.

5. Exit your text editor and remain in the sample directory to link the 
executable file.

Linking User Tasks to the Simulation Executable File.  
VPOWER provides two ways to link the user tasks to your simulator 
executable file: by using the vconfig utility or by using a UNIX 
makefile. Each method links your simulator to the VPOWER user 
tasks. Choose the method that you find familiar or comfortable.

Using vconfig to Link the Executable File. The vconfig utility 
creates a script called cr_vlog. The cr_vlog script links your 
Verilog-XL simulator’s executable file to the VPOWER user tasks. 
You must define the name of the executable file created by cr_vlog, 
for example, verilog_toggle.
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To use the vconfig method to link your executable file,

1. Use your vconfig utility or an equivalent utility to generate the 
cr_vlog script or an equivalent script.

2. In the script, set an environment variable pointing to the directory 
of the generated library archive. For example (if you are using 
Solaris 7 or later),

setenv PPLILIB "../../lib-sparcOS5/libvpower.a"

3. In cr_vlog, look for the line that includes the math libraries:

-lm \

4. Add a line above this line to include the libvpower.a library. For 
example,

$PPLILIB \
-lm \

5. Run cr_vlog.

% cr_vlog

This script links your executable file to the VPOWER user tasks 
and creates the customized executable file called verilog_toggle. 
For details about linking the programmable language interface 
(PLI) by using the vconfig utility, see the Power Compiler User 
Guide.

Proceed to “Copying the Linked Executable File” on page 3-16.

Using a Makefile to Link the Executable File. Using the UNIX 
make command, you can use a makefile to link your Verilog-XL 
executable file to the VPOWER user tasks. The makefile creates a 
modified executable file called verilog_toggle.
3-15

Installing the Synopsys Synthesis Tools (version V-2003.12)



Two makefiles exist: Makefile.sol and Makefile.hp.

To use the makefile method to link your executable file,

1. Using a text editor such as vi, edit the appropriate makefile to set 
variable values for VERILOG_LIB and VERILOG_INC.

Modify the lines in the makefile to read according to your data. 
For example, enter

VERILOG_LIB = path1
VERILOG_INC = path2

where path1 is the path to your Verilog distribution .o and .a files, 
and path2 is the path to your Verilog distribution .h files.

The VERILOG_LIB variable must point to the directory path of 
the vlog.o and omnitasks.o files. The VERILOG_INC variable 
must point to the directory path of the acc_user.h and veriuser.h 
files.

2. Save the modified makefile and exit your text editor.

3. Use the make utility to link the executable file.

% make -f Makefile.platform

The platform extension is sol or hp.

The make command uses the modified makefile to link your 
executable file, creating a customized executable file called 
verilog_toggle.

Copying the Linked Executable File. After you create your 
customized executable file, change the permissions so that the file is 
not writable, and copy it to a directory suitable for group access.
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Enter the following commands at the UNIX prompt:

% chmod ogu-w verilog_toggle

This removes write access to other, group, and user.

% cp verilog_toggle site_verilog_bin_location

This copies the file to the site_verilog_bin_location directory for 
group access.

VCS Simulator

The following procedure describes how to link VPOWER to a version 
of VCS that contains the standard features you normally use at your 
site and includes the toggle count utilities needed for Power 
Compiler.

Note:   
The PLI library has been tested with VCS version 3.0 and later 
versions. 

To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of the PLI table file.

3. Compile the simulation executable file.

The following sections describe these steps.

Changing to the Synopsys vpower Directory. All directories 
listed are relative to the root of the vpower directory: $SYNOPSYS/
auxx/syn/power/vpower.
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1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS synthesis_root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the PLI Table File. To modify the PLI table file 
(vpower.tab) to define the new toggle count utilities,  

1. Change to the vcs/vcs.sample directory, and review the sample 
vpower.tab file, which shows the edits you will have to make.

% cd vcs/vcs.sample

2. Make the necessary changes to the vpower.tab file.

Compiling the Simulation Executable File. VCS is a compiled 
simulator, so you must compile your designs along with VCS libraries 
to make a simulation executable file. To add PLI functionality to the 
simulation executable file, you need to link an extra PLI library when 
you compile your designs.

For Solaris the appropriate PLI library is

../../lib-sparcOS5/libvpower.a

You normally get a VCS simulation executable file by entering the 
following command at the UNIX prompt:

% vcs -Mupdate your_verilog_design_files compiler_options
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 To link with the PLI library, enter 

% vcs -Mupdate \ 
    -P $SYNOPSYS/auxx/syn/power/vpower/vcs/vcs.sample/vpower.tab \   
   your_verilog_design_files compiler_options \
   $SYNOPSYS/auxx/syn/power/vpower/lib-sparcOS5/libvpower.a

This generates an executable file called simv that includes PLI 
functionality.

Note:   
You can copy vpower.tab and libvpower.a into any file locations 
that are convenient for you.

Using SoCBIST 

To insert SoCBIST into your design, you need DFT Compiler, which 
installs with the synthesis tools. You also need TetraMAX if you want 
to use the SoCBIST pattern generation functionality. You can install 
TetraMAX as an overlay on the synthesis tools or as a stand-alone 
installation.  For required SoCBIST environment variables, see 
“Setting Up the User Environment” on page 18-6. 
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Verifying the Synthesis Tools Installation

Note:   
The Synopsys Common Licensing (SCL) software must be 
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
must be defined before you can verify the synthesis tools 
installation. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

To verify installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke one of the synthesis tools on a licensed machine. For 
example, invoke Design Compiler, Library Compiler,  Design 
Analyzer, or Design Vision by entering one of the following 
commands: 

% $SYNOPSYS/platform/syn/bin/dc_shell

% $SYNOPSYS/platform/syn/bin/lc_shell

% $SYNOPSYS/platform/syn/bin/design_analyzer

% $SYNOPSYS/platform/syn/bin/design_vision

Replace platform with the appropriate platform. 

For the most recent information about tool-specific platform 
support, see the documentation for your product.
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Note:   
You can verify other synthesis tools by using the preceding 
command. Simply replace the executable file name with the 
name of another synthesis tool.

If you get the correct prompt, or if a GUI appears, the installation was 
successful. 
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Installing AMPS (version U-2003.03) 4

This chapter contains the following sections:

• Installing the Software

• Setting Up AMPS for Each User

• Verifying the AMPS Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install AMPS from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the AMPS software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. AMPS is installed in a similar 
manner. 

The AMPS tool is on the PathMill CD. AMPS is a stand-alone product 
and cannot be installed over an existing Synopsys product, including 
a prior version of AMPS. You must create a new directory for AMPS.

Setting Up AMPS for Each User

To set up a new AMPS tool user, add the AMPS directory containing 
the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/amps/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/amps/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-6).
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Verifying the AMPS Installation

To verify the AMPS installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/amps/bin/amps

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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Installing Arcadia (version U-2003.03) 5

This chapter contains the following sections:

• Installing the Software

• Setting Up Arcadia for Each User

• Verifying the Arcadia Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install Arcadia from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the Arcadia software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-1 on page 2-10 shows a Synopsys media 
installation script for the synthesis tools. Arcadia is installed in a 
similar manner. 

Arcadia is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of Arcadia. You 
must create a new directory for Arcadia.

Setting Up Arcadia for Each User

To set up a new Arcadia tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install_directory
% source CSHRC_platform

The install script for Arcadia creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.

The CSHRC_platform file contains the line

set path=(install_directory/platform/arc/bin $path)
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where install_directory is the directory in which the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the preceding 
line and set the path from that file.

• If you are using the Bourne or Korn shell, add the following line 
to the .profile file or .kshrc file:

PATH=install_directory/platform/arc/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Verifying the Arcadia Installation

To verify the Arcadia installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% DBCONVERT --version

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Run the Arcadia GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/arc/bin/sviewer 

4. Exit the GUI by choosing File > Exit in any GUI window.
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Installing Cadabra (version 7.0) 6

This chapter contains the following sections:

• Installing the Software

• Setting the Environment Variables

• Verifying the Cadabra Installation

• Customer Support

To ensure a successful installation, complete the following procedure 
before beginning the installation process:

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 15).
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Installing the Software

Cadabra is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of Cadabra. You 
must create a new directory for Cadabra.

To download and install Cadabra by electronic software transfer 
(EST),

1. Create a Cadabra installation directory and change to that 
directory. For example, enter

% mkdir /u/edatools/cadabra-version 
% cd /u/edatools/cadabra-version 

2. Download the software to the installation directory.

3. Uncompress and untar the files.

% gzip -dc cadabra_platform_version.tar.gz | tar xvf -

This command creates a Cadabra subdirectory named after the 
release of Cadabra that you are installing. 

To install Cadabra from a CD,

1. Mount the CD by using the appropriate command for your 
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:   

Mounting instructions are different for each platform. See your 
system documentation for the correct CD mounting 
commands.
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Also, for sparcOS5 with vold (the volume management 
daemon for managing CD and floppy devices), the /cdrom 
directory already exists and the CD is automatically mounted. 
Therefore, use cd /cdrom/cdrom0 instead of cd /cdrom.

2. Create a Cadabra installation directory and change to that 
directory. For example,

% mkdir /u/edatools/cadabra-version 
% cd /u/edatools/cadabra-version 

3. Uncompress and untar the files.

% gzip -dc /cdrom/cadabra7.0/cadabra_platform_version.tar.gz | tar xvf -

This command creates a Cadabra subdirectory named after the 
release of Cadabra that you are installing. 

4. Unmount the CD by using the appropriate command for your 
operating system. For example, enter

% umount /cdrom

Note:   

If you are running the volume management daemon, use the 
eject command to unmount the CD.
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Setting the Environment Variables

This section discusses the following environment variables:

• CADABRAHOME 

• LM_LICENSE_FILE 

It is recommended that you place these variables in your $HOME/
.cshrc or $HOME/.profile file as your default settings. 

Setting the CADABRAHOME Environment Variable

Follow these steps.

1. Set the $CADABRAHOME environment variable to point to your 
Cadabra installation subdirectory.

- If you are using the C shell, add the following line:

% setenv CADABRAHOME /u/edatools/cadabra-version

- If you are using the Bourne shell, add these lines:

% CADABRAHOME=/u/edatools/cadabra-version
export CADABRAHOME

2. Add $CADABRAHOME/bin to your search path:

- If you are using the C shell, enter

set path=($CADABRAHOME/bin $path)

- If you are using the Bourne shell, enter

PATH=$CADABRAHOME/bin:$PATH
export PATH
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Setting the LM_LICENSE_FILE Environment Variable

To enable Cadabra to check out a license, you must set the 
LM_LICENSE_FILE environment variable. 

• If you are using the C shell, enter

% setenv LM_LICENSE_FILE 27000@my_server

• If you are using the Bourne shell, enter

% LM_LICENSE_FILE=27000@my_server
export SNPSLMD_LICENSE_FILE

The port and host name variables correspond to the TCP port and 
license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@host rather than using the path to 
the license file.

You can specify multiple license files by separating each entry with a 
colon (:).
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Verifying the Cadabra Installation

To verify the Cadabra installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. If you are using a display that is not local, set the DISPLAY 
environment variable.

% setenv DISPLAY my_display:0.0

3. Invoke the tool by entering 

% tool_name 

Replace tool_name with abracad, abramap, or kazam.

If the product GUI appears, the installation was successful.

4. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

For information about accessing customer support, see “Customer 
Support” on page xxi. You can also send an e-mail message to 
Cadabra Support at cadabrasupport@synopsys.com.
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Installing Floorplan Compiler 
(version V-2003.12) 7

This chapter contains the following sections:

• Installing the Software

• Setting Up Floorplan Compiler for Each User

• Verifying the Floorplan Compiler Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Installing the Software

To download and install Floorplan Compiler from the Web or by FTP, 
follow the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To install the Floorplan Compiler software from the CD, follow the 
installation procedure described in “Installing Product Files From a 
CD” on page 2-7. Example 2-1 on page 2-10 shows a Synopsys 
media installation script for the synthesis tools. Floorplan Compiler is 
installed in a similar manner. 

Setting Up Floorplan Compiler for Each User

To set up a new Floorplan Compiler tool user, add the Floorplan 
Compiler directory containing the executable file to the PATH 
environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fpc/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/fpc/bin:$PATH
export PATH
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Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-6).

Configuring the Browser for Floorplan Compiler Online 
Help 

The Floorplan Compiler online Help system is a browser-based 
HTML Help system. For optimal viewing, use Netscape Navigator 
version 4.78 for UNIX. This Help system is not supported in 
Netscape Navigator version 6 or later.

Important:   
When you use online Help from within the GUI, the Netscape 
executable file must be on the UNIX path.

Floorplan Compiler Help makes extensive use of Java, JavaScript, 
and style sheets. In your browser preferences, select the Advanced 
category and make sure that 

• The Enable Java applets, Enable JavaScript, and Enable Style 
Sheets options are all selected

• The Enable Java Plugin option is deselected

You can open the Help system from within the Floorplan Compiler 
GUI tool or stand-alone in Netscape Navigator. 
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Verifying the Floorplan Compiler Installation

To verify the Floorplan Compiler installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/fpc/bin/fpc_shell

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit fpc_shell by entering exit on the command line.

4. Run the Floorplan Compiler GUI on each installed platform by 
entering the following command:

% $SYNOPSYS/platform/fpc/bin/fpc_gui

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

5. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up Formality for Each User

• Verifying the Formality Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install Formality from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the Formality software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for the PrimeTime tool. Formality is installed in a 
similar manner. 

Formality is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of Formality. You 
must create a new directory for Formality.

Setting Up Formality for Each User

To set up a new Formality tool user, add the Formality directory 
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/fm/bin:$PATH
export PATH
8-2

Installing Formality (version V-2003.12)



Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-6).

For information about the Synopsys setup file, see the Formality 
User Guide. 

Verifying the Formality Installation

To verify the Formality installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the Formality shell by entering the following command: 

% $SYNOPSYS/platform/fm/bin/fm_shell

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit fm_shell by entering exit on the command line.

4. Run the Formality GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/fm/bin/formality

5. Exit the GUI by choosing File > Exit in any GUI window.
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Installing FPGA Compiler II (version 
T-2003.09-FC3.8) on UNIX Platforms 9

This chapter explains how to install FPGA Compiler II on a 
workstation running Solaris or HP-UX. For instructions on how to 
install FPGA Compiler II on a system running a Windows NT 
platform, see Chapter 10, “Installing FPGA Compiler II (version 
T-2003.09-FC3.8) on Windows Platforms.”

This chapter contains the following sections:

• Product Support

• System Requirements

• Installing the Software

• Enabling Online Document Readers
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Product Support

The FPGA Solutions Web page is regularly updated. Check it for 
application notes, online Help updates, and other valuable 
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements

Table 9-1 shows the minimum system requirements for UNIX 
installations of FPGA Compiler II.      

Table 9-1 UNIX System Requirements

Operating system Memory Disk space for installation

Solaris 7, 8
 (32-bit mode only)

64 MB of RAM

140 MB of swap space1

1. 200 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger 
designs might require more memory. 

100–150 MB

HP-UX 11.0, 11.11 (11i) 
(32-bit mode only)

64 MB of RAM

140 MB of swap space1
100–150 MB
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Installing the Software

Mounting the CD might require root access privileges. If you do not 
have root access privileges, see your system administrator for 
instructions on mounting the CD.

To install FPGA Compiler II,

1. Mount the CD-ROM, following the instructions in “Mounting the 
CD” on page 2-8.

2. Make sure that your licensing software is installed. For 
information on Synopsys Common Licensing (SCL) software, 
see “Acquiring a License” on page 1-15.

3. Change directory to the UNIX directory of the CD-ROM. For 
example, 

% cd /cdrom0/UNIX

4. Run the setup script setup.csh from the UNIX directory of the 
CD-ROM drive and follow the instructions.

5. For a typical shared installation, choose option 1 to install the 
software and set up the license path. 

6. Next, choose option 1 for Solaris, option 2 for HP-UX, or option 3 
for both platforms.

7. Enter the path to the network keys in the format port@hostname 
(for example, 27000@keyserv).
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Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable 
Document Format (PDF).

To read this online document, you must have version 4.0 or later of 
Adobe Acrobat Reader with Search plug-in installed on your system. 
To install Acrobat Reader with Search plug-in, download the latest 
version of Acrobat Reader from the Adobe home page, at

http://www.adobe.com

For more information, see “Downloading and Installing Acrobat 
Reader from the Web” on page 23-3.
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Installing FPGA Compiler II (version 
T-2003.09-FC3.8) on Windows Platforms 10

You can install the FPGA Compiler II software to run PC running 
Windows. The procedure is explained in the following sections:

• Product Support

• System Requirements for Windows

• Installing FPGA Compiler II

• Enabling Online Document Readers
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Product Support

The FPGA Solutions page on the Synopsys World Wide Web site is 
regularly updated with the latest information. Check this page to find 
application notes, online help updates, and other valuable 
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements for Windows

Table 10-1 shows the minimum system requirements for installing 
FPGA Compiler II on Windows.

Table 10-1 Windows System Requirements

Operating system Memory Disk space for installation

Windows NT 4.0 (Service Pack 
4 or later), Windows 98, 
Windows ME, or Windows 2000

32 MB of RAM

70 MB of swap space1

1. 100 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger designs 
might require more memory.

50–270 MB, depending on file 
system and partition size (50 
MB for NTFS or small FAT 
partition and 270 MB for large 
FAT partition)
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Installing FPGA Compiler II 

You can install FPGA Compiler II on a PC running Windows by 
downloading the tool from the Web or installing it from the CD.

Note:   
Make sure that your licensing software is installed. For 
information on Synopsys Common Licensing (SCL) software, 
see “Acquiring a License” on page 1-15.

To install FPGA Compiler II from the Web, 

• Go to

http://www.synopsys.com/products/fpga/download_fc2.html 

and follow the instructions.

To install FPGA Compiler II from the CD, do the following:

1. Insert the FPGA Compiler II CD into your computer’s CD drive. 

In most cases, the setup program automatically starts. If the 
setup program does not start automatically, run setup.exe from 
the CD directory.

2. Follow the instructions on the screen.

As you move through the installation screens, note the following:

- You can install a subset of the available target devices to save 
disk space. To do this, select Custom in the Setup Type dialog 
box and follow the instructions.
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- The program installation directory path cannot contain space 
characters.

Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable 
Document Format (PDF). The setup program installs this document 
in the directory where you installed the software. 

To read the Synopsys FPGA online document, you must have Adobe 
Acrobat Reader version 4.0 or later installed on your system. Install 
Acrobat Reader version 4.0 by one of the following methods:

• To install Acrobat Reader on a Windows system from within 
FPGA Compiler II, enter the following command:

CD_ROM_drive:\acrosrch\32bit\setup

• Download the latest Acrobat Reader from the Adobe home page, 
at

http://www.adobe.com

For more information, see “Downloading and Installing Acrobat 
Reader from the Web” on page 23-3.
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This chapter contains the following sections:

• Installing the Software 

• Setting Up NanoSim for Each User

• Verifying the NanoSim Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software 

To download and install NanoSim from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the NanoSim software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. NanoSim is installed in a similar 
manner. 

The NanoSim subtools (ADFMI, NanoSim Integration with VCS, 
TurboWave, Verilog-A, VTRAN, and CosmosScope) are 
automatically installed with the NanoSim installation. 

NanoSim can be installed as a stand-alone installation or with any of 
the tools (PowerMill and TimeMill) it comes packaged with.

Setting Up NanoSim for Each User

To set up a new NanoSim tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install_dir
% source CSHRC_platform

The install script for NanoSim creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.
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The CSHRC_platform file sets the path for NanoSim, 
CosmosScope, and the NanoSim man pages.

set path=(install_directory/platform/ns/utilities/ \
   cosmos/ai_bin $path)

setenv MANPATH install_directory/doc/ns/man:$MANPATH

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=install_directory/platform/ns/utilities/ \ 
 cosmos/ai_bin:${PATH}
export Path

MANPATH=install_directory/doc/ns/man:$MANPATH
export MANPATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).
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Verifying the NanoSim Installation

To verify the NanoSim installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering the following command: 

% nanosim

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Run the NanoSim GUI on each installed platform by entering the 
following command:

% nanosimgui

4. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PathMill for Each User

• Verifying the PathMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PathMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the PathMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. PathMill is installed in a similar 
manner. 

PathMill is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of PathMill. You 
must create a new directory for PathMill.

Setting Up PathMill for Each User

To set up a new PathMill tool user, add the PathMill directory 
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/pm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/pm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-6).
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Verifying the PathMill Installation

To verify the PathMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/pm/bin/pathmill

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up PowerMill for Each User

• Verifying the PowerMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PowerMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the PowerMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. PowerMill is installed in a similar 
manner. The PowerMill subtools (ADFMI, TurboWave, and VTRAN) 
are automatically installed with the PowerMill installation.

PowerMill can be installed as a stand-alone installation or with any of 
the tools (NanoSim and TimeMill) it comes packaged with.

Setting Up PowerMill for Each User

To set up a new PowerMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install_dir
% source CSHRC_platform

The installation script for PowerMill creates a CSHRC_platform 
file for each platform installed. The term platform is replaced with 
the platform you installed.
13-2

Installing PowerMill (version U-2003.03)



The CSHRC_platform file sets the path for NanoSim and the 
NanoSim man pages.

set path=(install_directory/platform/ns/bin $path)

setenv MANPATH install_directory/doc/ns/man:$MANPATH

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the preceding 
line and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile or .kshrc file:

PATH=install_directory/platform/ns/bin:$PATH
export PATH

MANPATH=install_directory/doc/ns/man:$MANPATH
export MANPATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).
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Verifying the PowerMill Installation

To verify the PowerMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% powrmill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up PrimePower for Each User

• Verifying the PrimePower Installation

To ensure a successful installation, have your license server running 
and have the appropriate license keys installed (see “Acquiring a 
License” on page 1-15).
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Installing the Software

Beginning with version version V-2003.12, PrimePower can be 
installed as a stand-alone tool only: It no longer overlays the 
synthesis tools. You must install PrimePower in its own directory.

To install the software, 

1. Download and install PrimePower from the Web or by FTP, 
following the instructions described in “Downloading and 
Installing the Software by EST” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-7. 
Example 2-1 on page 2-10 shows a Synopsys media installation 
script for the synthesis tools. PrimePower is installed in a similar 
manner. 

Note:   

When you are prompted to select the product you want to 
install, enter pps.

2. Make sure that your licensing software is installed. For 
information on SCL software, see “Acquiring a License” on 
page 1-15.

Setting Up PrimePower for Each User

To set up a new PrimePower tool user, add the PrimePower directory 
containing the executable file to the PATH environment variable.
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• If you are using the C shell, add the following line to the .cshrc file:

set path=(/install_directory/platform/syn/bin $path)

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=/install_directory/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Verifying the PrimePower Installation

To verify the PrimePower installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering the following command: 

% pp_shell

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit pp_shell by entering exit on the command line.

4. Run the PrimePower GUI on each installed platform by entering 
the following command:

% primepower &

5. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PrimeTime for Each User

• Verifying the PrimeTime Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PrimeTime from the Web or by FTP, follow 
the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To install the PrimeTime software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. 

PrimeTime is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of PrimeTime. 
You must create a new directory for PrimeTime.

Note:   
You can not install PrimeTime as an overlay product in the same 
directory as the synthesis tools.

Setting Up PrimeTime for Each User

PrimeTime does not require the $SYNOPSYS variable. If you have 
installed other Synopsys tools, such as the synthesis tools, that use 
the $SYNOPSYS variable, a conflict might arise. To avoid this, do the 
following:

• Set another variable for PrimeTime, for example, $STATIC.

• Set the PrimeTime $SYNOPSYS variable in a tool-specific setup 
file, not in the .profile or .cshrc file. 

• Create an alias for PrimeTime in the .cshrc, .profile, or .bashrc 
files. For example,
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For .cshrc files,   

% alias pt_setup ’setenv SYNOPSYS /path/to/
PrimeTime_root; echo "PrimeTime tools setup "’ 

For .profile or .bashrc files,

% alias pt_setup = ’set SYNOPSYS=/path/to/PrimeTime_root; 
echo "PrimeTime tools setup"’

 Execute the alias before executing PrimeTime.

To set up a new PrimeTime user,

1. Add the PrimeTime directory containing the executable file to the 
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Note:   

If you are using another variable “such as $STATIC” to define 
the PrimeTime root directory, substitute that variable for 
$SYNOPSYS in the remainder of this chapter.

2. Place a .synopsys_pt.setup file in the user’s home directory.

If you are using the C shell, enter
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  % cp $SYNOPSYS/admin/setup/.synopsys_pt.setup ~/.synopsys_pt.setup

If you are using the Bourne, Korn, or Bash shell, enter

  # cp $SYNOPSYS/admin/setup/.synopsys_pt.setup $HOME/.synopsys_pt.setup

You can modify this file to customize the settings for each user.

Verifying the PrimeTime Installation 

Note:   
The Synopsys Common Licensing (SCL) software must be 
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
must be defined before you can verify the PrimeTime tools 
installation. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

To verify installation of PrimeTime,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering one of the following commands on a 
licensed machine:

% $SYNOPSYS/platform/syn/bin/pt_shell

% $SYNOPSYS/platform/syn/bin/primetime

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

If you get the correct prompt, or if a GUI appears, the installation was 
successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up RailMill for Each User

• Verifying the RailMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install RailMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the RailMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-1 on page 2-10 shows a Synopsys media 
installation script for the synthesis tools. RailMill is installed in a 
similar manner. 

RailMill is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of RailMill. You 
must create a new directory for RailMill.

Setting Up RailMill for Each User

To set up a new RailMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install_directory
% source CSHRC_platform

The install script for RailMill creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/rm/bin $path)
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where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=install_directory/platform/rm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Verifying the RailMill Installation

To verify the RailMill installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering the following command: 

% railmill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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3. Run the RailMill GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/rm/bin/chipviewer

4. Exit the GUI by choosing File > Exit, and clicking Yes in the dialog 
box.
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Installing System Studio (version V-2003.12)17

This chapter contains the following sections:

• Installing the Software

• Setting Up System Studio for Each User

• Verifying the System Studio Installation

• Troubleshooting Startup Problems

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Note:   
For detailed information on operating systems and acquiring 
patches, see “Supported Platforms and Operating Systems” on 
page 1-2.

Installing the Software

To download and install System Studio from the Web or by FTP, 
follow the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To install the System Studio software from the CD, follow the 
installation procedure described in “Installing Product Files From a 
CD” on page 2-7. Example 2-1 on page 2-10 shows a Synopsys 
media installation script for the synthesis tools. System Studio is 
installed in a similar manner. 
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Setting Up System Studio for Each User

Set the defaults for each user according to the user’s shell and 
operating system. Table 17-1 lists the path name and description of 
systemwide defaults for System Studio. 

For C Shell Users 

To use the C shell to set up a new System Studio tool user, 

1. Add the System Studio executable directory to the PATH 
environment variable.

Add the following line to the .cshrc file:

setenv SYNOPSYS_CCSS ccss_home/platform/ccss
setenv CCSS_SIM_DIR ccss_sim_dir
set path = ($SYNOPSYS_CCSS/bin $path)

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Table 17-1 System Studio Systemwide Defaults  

Path name Description

SYNOPSYS_CCSS Identifies the System Studio installation 
directory. For example, 
$SYNOPSYS/sparcOS5/ccss.

CCSS_SIM_DIR Path to the directory for code generation and 
simulation results (defaults to $HOME/ccss/sim)

CCSS_KEYS Specifies the complete file name of the license 
file. If CCSS_KEYS is not set, the tool searches 
for other license keys in the following order:
- SNPSLMD_LICENSE_FILE
- LM_LICENSE_FILE
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Note:   

You can define CCSS_SIM_DIR, but if it is not set, the GUI 
provides a reasonable default.

2. Point to your license key file by adding one of the following lines 
to your ~/.cshrc file:

setenv CCSS_KEYS   /path/to/synopsys.lic 

3. If the paths to the C++ compiler, debugger, and make command 
are not already included in your ~/.cshrc file, add the following 
line to your ~/.cshrc file:

set path = (compiler_home/bin make_home/bin $path) 

4. To source the CCSS setup file, add the following line to your  
~/.cshrc file:  

 source $SYNOPSYS_CCSS/../gnupackages/source_me.csh

5. Make these changes effective by logging out and logging in again 
or by entering the following command:

% source ~/.cshrc

For Bourne Shell Users 

To use the Bourne, Korn, or Bash shell to set up a new user, 

1. In your $HOME directory, add the following lines to the 
appropriate user setup file (.profile, .kshrc, or .bashrc).

SYNOPSYS_CCSS=ccss_home/platform/ccss 
export SYNOPSYS_CCSS 

CCSS_SIM_DIR=ccss_sim_dir 
export CCSS_SIM_DIR 
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PATH=$SYNOPSYS_CCSS/bin:$PATH
export PATH 

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).

Note:   

You can define CCSS_SIM_DIR, but if it is not set, the GUI 
provides a reasonable default.

2. If the System Studio license file will not be installed in the default 
location, add the following lines to your setup file:

CCSS_KEYS=lic_file
export CCSS_KEYS

3. If the paths to the C++ compiler, debugger, and make command 
are not already included in your setup file, add the following lines 
to it:

PATH=compiler_home/bin:make_home/bin:$PATH 
export PATH 

4. To source the CCSS setup file, add the following line to your 
setup file:

. $SYNOPSYS_CCSS/../gnupackages/source_me.sh

5. Make these changes effective by logging out and logging in 
again, or by entering 

 $. $HOME/setup_file

where setup_file is .profile, .kshrc, or .bashrc.
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VHDL Simulation

If you intend to use the external simulation interface for VHDL 
cosimulation under the algorithmic domain of System Studio, you 
must ensure that the VHDL packages are analyzed before you use 
them. Your system administrator should analyze the files when 
System Studio is installed. 

The relevant commands are

% cd $SYNOPSYS_CCSS/packages/vsscli/src
% vhdlan -nc ccss_vsscli_package.vhdl
% cd $SYNOPSYS_CCSS/platform/ccss/packages/bittrue/
vhdlsynopsys/src
% vhdlan -nc ccss_PACKAGE_SYNOPSYS.vhdl 
LIB_0_0_1_PACKAGE_SYNOPSYS.vhdl

Verifying the System Studio Installation

To verify the System Studio installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% ccss &

If System Studio is correctly installed, this command invokes System 
Studio, displays the System Studio welcome screen, and then opens  
System Studio.
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Troubleshooting Startup Problems

This section addresses common startup problems.

Key File Problems

To test the System Studio installation, start the System Studio 
Design Center. If the software does not start, check the contents of 
the key file as follows:

1. If you are using a network license file, check the first line of the 
key file and make sure the host name and the host ID match 
those of the machine on which the license is running.

SERVER hostname hostid 26585

2. If you are using a network license file, check the second line of 
the key file and make sure the path to snpslmd exists and is 
correct.

VENDOR snpslmd scl_root/platform/bin/snpslmd

In this line, platform is the operating system keyword (see 
Table 1-1 on page 1-3). Make sure there are no blank lines and 
no leading or trailing spaces in the license file.

3. For all types of license files, make sure that all System Studio 
users have read access to the key file.

Set the file permission for the key file with the following 
command:

% chmod 644 $CCSS_KEYSS/ccss/admin/license/CCSS.keys 

Or, if you have defined the symbol CCSS_KEYS, use this 
command:
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% chmod 644 $CCSS_KEYS

Then use the following command to check that the read access 
is correct:

% ls -l $SYNOPSYS_CCSS/../../ccss/admin/license/
CCSS.keys

You should see a report something like this:

-rw-r--r-- 1 thisuser group 4623 Apr 26 11:09 ccss.keys

Insufficient Interprocess Communication (IPC) 
Semaphores

When starting System Studio or DAVIS on Solaris 5.x platforms, if 
you see the following report,

sem_create->semget->IPC_CREATE: No space left on device
GMA failed
FATAL: Exec_ .../sparcOS5/ccss/bin/ccss_exec_ failed:status = 139 

you need to increase the number of system semaphores. Add the 
following command to the /etc/system file (see the man page 
system(4) for details):

set semsys:seminfo_semmnu=0x100

After you change the /etc/system file, restart your system by using 
boot -r.

Caution!   
Changing the /etc/system file incorrectly will prevent the 
system from starting.
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This chapter contains the following sections:

• Installing TetraMAX

• Setting Up the User Environment

• Verifying the TetraMAX Installation

If you are installing TetraMAX stand-alone, to ensure a successful 
installation complete the following procedures before beginning the 
installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Installing TetraMAX

This section describes Synopsys license key requirements and the 
two types of installation for TetraMAX ATPG and TetraMAX IddQTest, 
version V-2003.12: 

• Stand-alone 

Install TetraMAX stand-alone in its own directory.

• Overlay 

Install TetraMAX overlay in the same directory as the V-2003.12 
synthesis tools. 

License Key Requirements

TetraMAX version V-2003.12 uses the Synopsys Common Licensing 
(SCL) system. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

Note:   
Optional features such as Diagnosis, IddQTest, PatternMap, and 
transition delay fault ATPG each require a separate license. For 
specific information on the licenses required for TetraMAX 
options, install the product and see the online Help for the 
“Understanding TetraMAX License Usage.” 
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64-Bit Mode on HP-UX and Solaris Platforms

In 64-bit mode, TetraMAX supports both the shell and GUI on HP-UX 
and Solaris platforms.

To invoke TetraMAX ATPG in 64-bit mode, use the -64 switch. 

% tmax -64 [other options]

An alternative method is to set the TMAX_64BIT environment 
variable to true (or to any string other than null).

% setenv TMAX_64BIT true
% tmax [other options]

Stand-Alone Installation

TetraMAX stand-alone is a complete installation of all TetraMAX 
applications. It must be installed in its own directory and not over an 
existing synthesis release.

To perform stand-alone installation, 

1. Download and install TetraMAX from the Web or by FTP, as the 
described in “Downloading and Installing the Software by EST” 
on page 2-2.

Or

Install the files from the TetraMAX CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-7. 
Example 2-1 on page 2-10 shows a Synopsys media installation 
script for the synthesis tools. TetraMAX is installed in a similar 
manner. 
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Note:   

When you are prompted to select the product you want to 
install, enter txs to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For 
information on SCL software, see “Acquiring a License” on 
page 1-15.

Overlay Installation

Install TetraMAX version V-2003.12 over version V-2003.12 of the 
synthesis tools only. (Do not install it over any other versions of the 
synthesis tools.)

You perform overlay installation in the directory in which you installed 
the Synopsys synthesis tools ($SYNOPSYS). You must log on as the 
same user who installed the Synopsys synthesis tools so that you 
have write permission in the $SYNOPSYS directory.

Note:   
If you have not installed the Synopsys synthesis tools, install 
them before proceeding with overlay installation (see 
Chapter 3, “). If you do not have the synthesis tools installed, the 
installation of TetraMAX overlay will not be allowed.

To perform overlay installation,

1. To download and install TetraMAX from the Web or by FTP, follow 
the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

Or
18-4

Installing TetraMAX (version V-2003.12)



Install the files from the TetraMAX CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-7. 
Example 2-1 on page 2-10 shows a Synopsys media installation 
script for the synthesis tools. TetraMAX is installed in a similar 
manner. 

Note:   

When you are prompted to select the product you want to 
install, enter tx to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are 
set up to work with the synthesis tools. If you encounter 
problems, see the SCL documentation, Licensing Quick Start 
and Licensing Installation and Administration Guide.

Optional Installation of IddQTest

The IddQTest option of TetraMAX is installed separately from 
TetraMAX ATPG and requires a special license. 

To install IddQTest,

1. Run the same installation script again, but enter idq at the 
“Product(s) Selected” prompt.

2. For the IddQTest target directory, specify the location where you 
installed the TetraMAX overlay product.

Note:   
The installation script does not allow you to install IddQTest into 
a TetraMAX stand-alone installation. To create a stand-alone 
installation of IddQTest, you must specify a completely separate 
directory. Once you have done this, manually copy IddQTest into 
the same directory as the TetraMAX stand-alone product.
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Setting Up the User Environment

The procedure for setting up a new TetraMAX user has changed. 
When you define the TetraMAX root directory, you can now use the 
$SYNOPSYS environment variable.  

Note:   
For backward compatibility, you can still set 
$SYNOPSYS_TMAX. If $SYNOPSYS_TMAX is set, it will override 
$SYNOPSYS. 

To set up a new TetraMAX tool user, add the TetraMAX directory 
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/bin:$PATH
export PATH

To set up the user environment by using an alias, perform one of the 
following procedures. Note that these examples are for the C shell. 
Setups in other shells will differ.

• To set up the user environment by using an alias, enter

% alias tmax ’$SYNOPSYS/bin/tmax \!*’

• To set up the user environment by using a path, enter

% set path=($SYNOPSY/bin $path)
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• To set up the user environment for using SoCBIST, enter

% set path=($SYNOPSYS/bin $SYNOPSYS/platform/bin $path)

Replace platform with the required platform.

Note:   

If you used $SYNOPSYS_TMAX to define the TetraMAX root 
directory, set the user environment for SOCBIST as follows:

% set path=($SYNOPSYS_TMAX/bin $SYNOPSYS/platform/bin $path)

Verifying the TetraMAX Installation

To verify installation of the TetraMAX tools,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the TetraMAX GUI by entering the following command on 
a licensed machine:

% tmax

If the GUI appears, the installation was successful.
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Installing TimeMill (version U-2003.03) 19

This chapter contains the following sections:

• Installing the Software

• Setting Up TimeMill for Each User

• Verifying the TimeMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
19-1



Installing the Software

To download and install TimeMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the TimeMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-7. Example 2-2 on page 2-13 shows a Synopsys media 
installation script for PrimeTime. TimeMill is installed in a similar 
manner. The TimeMill subtools (ADFMI, TurboWave, and VTRAN) 
are automatically installed with the TimeMill installation.

TimeMill can be installed as a stand-alone installation or with any of 
the tools (NanoSim and PowerMill) it comes packaged with.

Setting Up TimeMill for Each User

To set up a new TimeMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install_dir
% source CSHRC_platform

The installation script for TimeMill creates a CSHRC_platform file 
for each platform installed. The term platform is replaced with the 
platform you installed.
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The CSHRC_platform file sets the path for Nanosim and the 
NanoSim man pages.

set path=(install_directory/platform/ns/bin $path)
setenv MANPATH install_directory//doc/ns/man:$MANPATH

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the preceding 
line and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile, .kshrc, or .bashrc file:

PATH=install_directory/platform/ns/bin:$PATH
export PATH

MANPATH=install_directory/doc/ns/man:$MANPATH
export MANPATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-6).
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Verifying the TimeMill Installation

To verify the TimeMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% timemill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting the Environment Variables

• Verifying the VCS and VCSi Installation

• Customer Support

To ensure a successful installation, complete the following procedure 
before beginning the installation process:

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

The instructions in this chapter also apply to VCSi.
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Note:   
The VirSim GUI installs with VCS. If you want to install the GUI 
as a stand-alone tool, see Appendix A, “Installing VirSim (version 
4.3).”

Installing the Software

VCS is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of VCS. You 
must create a new directory for VCS.

To download and install VCS by electronic software transfer,

1. Create a VCS installation directory and change to that directory. 
For example, enter

% mkdir /u/edatools 
% cd /u/edatools

2. Download the software to the installation directory.

3. Uncompress and untar the files.

% gzip -dc /u/edatools/vcs_platform_version.tar.gz | tar 
xvf -

This command creates a VCS subdirectory named after the 
release of VCS that you are installing. 

To install VCS from a CD,

1. Create a VCS installation directory and change to that directory. 
For example,

% mkdir /u/edatools/vcs
% cd /u/edatools/vcs
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2. Mount the CD by using the appropriate command for your 
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:   

Mounting instructions are different for each platform. See your 
system documentation for the correct CD mounting 
commands.

Also, for sparcOS5 with vold (the volume management 
daemon for managing CD and floppy devices), the /cdrom 
directory already exists and the CD is automatically mounted. 
Therefore, use cd /cdrom/cdrom0 instead of cd /cdrom (and 
use eject to unmount the CD). 

3. Unmount the CD by using the appropriate command for your 
operating system. For example, enter

% umount /cdrom

Note:   

If you are running the volume management daemon, use the 
eject command to unmount the CD.
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Setting the Environment Variables

This section discusses the following environment variables:

• $VCS_HOME or $VCSI_HOME

• SNPSLMD_LICENSE_FILE 

• LM_LICENSE_FILE

It is recommended that you place these variables in your $HOME/
.cshrc or $HOME/.profile file as your default settings. 

Setting the $VCS_HOME Environment Variable

Follow these steps.

1. Set the $VCS_HOME environment variable to point to your VCS 
installation subdirectory.

- If you are using the C shell, add the following line:

% setenv VCS_HOME /u/edatools/vcs7.0.2

- If you are using the Bourne shell, add these lines:

% VCS_HOME=/u/edatools/vcs7.0.2
export VCS_HOME

2.  Add $VCS_HOME/bin to your search path:

- If you are using the C shell, enter

set path=($VCS_HOME/bin $path)

- If you are using the Bourne shell, enter

PATH=$VCS_HOME/bin:$PATH
export PATH
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3. (Optional) To include the optional utilities shipped with VCS in the 
path, 

- If you are using the C shell, enter

set path = ($VCS_HOME/bin \
$VCS_HOME/‘$VCS_HOME/bin/vcs -platform‘/bin \
$VCS_HOME/‘$VCS_HOME/bin/vcs -platform‘/util \
$path)

- If you are using the Bourne shell, enter

PATH=$VCS_HOME/bin \
$VCS_HOME/‘$VCS_HOME/bin/vcs -platform‘/bin \
$VCS_HOME/‘$VCS_HOME/bin/vcs -platform‘/util \
$PATH
export PATH

Setting the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE Environment Variable

To enable VCS to check out a license, you must set the 
SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment 
variable. 

• If you are using the C shell, enter the following line:

% setenv LM_LICENSE_FILE 27000@my_server

• If you are using the Bourne shell, enter these lines:

% SNPSLMD_LICENSE_FILE=27000@my_server
export SNPSLMD_LICENSE_FILE
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The port and host name variables correspond to the TCP port and 
license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@host rather than using the path to 
the license file.

Each license file can contain licenses for many packages from 
multiple vendors. You can specify multiple license files by separating 
each entry with a colon (:).

Verifying the VCS and VCSi Installation

To verify the VCS and VCSi installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering 

% vcs -ID

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Run the VirSim GUI on each installed platform by entering 

% vcs -RPP

4. Exit the GUI by choosing File > Exit in any GUI window.
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Customer Support

The VCS support page on the Synopsys Web site is regularly 
updated with the latest information. Check this page for application 
notes, online help updates, and other valuable information:

http://www.synopsys.com/products/simulation/simulation.html

You can also send an e-mail message to VCS Support at 
vcs_support@synopsys.com.
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This chapter contains the following sections: 

• Downloading and Installing the Software

• Setting the Environment Variables

• Customer Support
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Downloading and Installing the Software

1. Create a Vera installation directory. For example,

% mkdir -p /usr/synopsys/vera

2. Download the Vera release to the installation directory. The latest 
Vera download instructions can be obtained from the SolvNet 
Release Library or from vera-support@synopsys.com.

If a Vera directory does not already exist, you must create one.

3. Uncompress and untar the files.

% pwd /usr/synopsys/vera
% gzip -dc vera-version-platform.tar.gz | tar xvf -

This will create a subdirectory in the Vera installation directory. 
For example, 

/usr/synopsys/vera/vera-version-platform

In the remainder of this chapter, this subdirectory is referred to as 
the Vera installation directory.

4. To set the file permissions on the new directory tree and its 
contents, enter

% chmod -R 755  /usr/synopsys/vera

5. Remove the vera-version-platform.tar.gz file.

% rm vera-version-platform.tar.gz

6. For each user, set the required environment variables. See 
“Setting the Environment Variables” on page 21-3.
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Setting the Environment Variables

This section discusses the following environment variables:

• VERA_HOME

• SNPSLMD_LICENSE_FILE

• LM_LICENSE_FILE

It is recommended that you place these variables in your 
$HOME/.cshrc or $HOME/.profile file as your default settings. 

Setting the $VERA_HOME Environment Variable

1. Set the $VERA_HOME environment variable to point to your Vera 
installation directory.

- If you are using the C shell, add the following line:

setenv VERA_HOME install_directory

- If you are using the Bourne shell, enter these lines:

VERA_HOME=install_directory
export VERA_HOME

2.  Add $VERA_HOME/bin to your search path.

- If you are using the C shell, enter

set path=($VERA_HOME/bin $path)

- If you are using the Bourne shell, enter

PATH=$VERA_HOME/bin:$PATH
export PATH
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Setting the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE Environment Variable

1. To enable Vera to check out a license, 
set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE 
environment variable. 

- If you are using the C shell, add the following line:

setenv SNPSLMD_LICENSE_FILE port@hostname

- If you are using the Bourne shell, enter these lines:

SNPSLMD_LICENSE_FILE=port@hostname
export SNPSLMD_LICENSE_FILE

The port and host name variables correspond to the TCP port 
and license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@host rather than using the path 
to the license file.

2. Each license file can contain licenses for many packages from 
multiple vendors. You can specify multiple license files by 
separating each entry with a colon (:).

Customer Support

You can get support for Vera from the following locations:

• For technical Issues, enhancement requests, and feedback, 
contact Customer Support at vera-support@synopsys.com.

• For documentation Issues, send e-mail to 
vera-doc@synopsys.com
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For general information on Synopsys licensing, see 
http://solvnet.synopsys.com/keys.

For information on Vera licensing, see

• The Vera Installation Guide, which is packaged in Portable 
Document Format (PDF) with the product files

• SolvNet article 900006, “VERA Licensing Structure,” at 
http://solvnet.synopsys.com/retrieve/900006
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This chapter contains instructions about installing the VHDL 
Simulation (Scirocco) tool in the following sections:

• Installing the Software

• Setting the Environment Variables

• Setting Up VHDL Simulation (Scirocco) for Each User

• Verifying the VHDL Simulation (Scirocco) Installation

The instructions in this chapter also apply to Scirocco-i.

To ensure a successful installation, have your license server running 
and have the appropriate license keys installed (see “Acquiring a 
License” on page 1-15).
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Note:   
The VirSim GUI installs with Scirocco. If you want to install the 
GUI as a stand-alone tool, see Appendix A, “Installing VirSim 
(version 4.3).”

Installing the Software

VHDL Simulation (Scirocco) is a stand-alone product and cannot be 
installed over an existing Synopsys product, including a prior version 
of VHDL Simulation (Scirocco). You must create a new directory for 
VHDL Simulation (Scirocco).

Note:   
The installation procedure for VHDL Simulation (Scirocco) has 
changed with this release.

To download and install VHDL Simulation (Scirocco) by electronic 
software transfer,

1. Create a VHDL Simulation (Scirocco) installation directory and 
change to that directory. For example, enter

% mkdir /u/edatools 
% cd /u/edatools

2. Download the software to the installation directory.

3. Uncompress and untar the files.

% gzip -dc /u/edatools/vcs_mx/
vcs_mx_platform_version.tar.gz | tar xvf -

This command creates a VHDL Simulation (Scirocco) 
subdirectory named after the release of VHDL Simulation 
(Scirocco) that you are installing. 
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To install VHDL Simulation (Scirocco) from a CD,

1. Create a VHDL Simulation (Scirocco) installation directory and 
change to that directory. For example,

% mkdir /u/edatools/vcs_mx
% cd /u/edatools/vcs_mx

2. Mount the CD by using the appropriate command for your 
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:   

Mounting instructions are different for each platform. See your 
system documentation for the correct CD mounting 
commands.

Also, for sparcOS5 with vold (the volume management 
daemon for managing CD and floppy devices), the /cdrom 
directory already exists and the CD is automatically mounted. 
Therefore, use cd /cdrom/cdrom0 instead of cd /cdrom.

3. Uncompress and untar the files.

% gzip -dc /u/edatools/vcs_mx/
vcs_mx_platform_version.tar.gz | tar xvf -

This command creates a Scirocco subdirectory named after the 
release of VHDL Simulation (Scirocco) that you are installing.

4. Unmount the CD by using the appropriate command for your 
operating system. For example, enter

% umount /cdrom
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Note:   

If you are running the volume management daemon, use the 
eject command to unmount the CD.

Setting the Environment Variables

This section discusses the following environment variables:

• SYNOPSYS_SIM

• SNPSLMD_LICENSE_FILE 

• LM_LICENSE_FILE

It is recommended that you place these variables in your $HOME/
.cshrc or $HOME/.profile file as your default settings. 

Setting the $SYNOPSYS_SIM Environment Variable

Set the SYNOPSYS_SIM environment variable in the shell that you 
are using in which the root_directory argument is the name of the 
Scirocco root directory.

- If you are using the C shell, enter 

% setenv SYNOPSYS_SIM /u/edatools/vcs_mx/
scirocco2002.12.2

- If you are using the Bourne shell, enter 

% SYNOPSYS_SIM=/u/edatools/vcs_mx/scirocco2002.12.2
export SYNOPSYS_SIM
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Setting the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE Environment Variable

To enable Scirocco to check out a license, you must set the 
SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment 
variable. 

• If you are using the C shell, enter the following line:

% setenv SNPSLMD_LICENSE_FILE 27000@my_server

• If you are using the Bourne shell, enter these lines:

% SNPSLMD_LICENSE_FILE=27000@my_server
export SNPSLMD_LICENSE_FILE

The port and host name variables correspond to the TCP port and 
license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@host rather than using the path to 
the license file.

Each license file can contain licenses for many packages from 
multiple vendors. You can specify multiple license files by separating 
each entry with a colon (:).
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Setting Up VHDL Simulation (Scirocco) for Each User

To set up a new Scirocco user, add the directory containing the 
Scirocco executable files to the PATH environment variable.

• If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS_SIM/bin $path)

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=(path:$SYNOPSYS_SIM/bin)
export PATH

Verifying the VHDL Simulation (Scirocco) Installation

To verify Scirocco installation, enter

% $SYNOPSYS_SIM/admin/install/sim/bin/verify_install

If Scirocco is correctly installed, the system responds by printing the 
following information and various copyright messages:

Info: Checking files in image
..........................................................
........................................... 
..........................................................
...............................
Info: Checking file permissions - passed
Info: Running Scirocco existence tests - passed
Verification of /u/edatools/vcs_mx/scirocco2002.12.2  
PASSED
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(version V-2003.12) 23

This chapter contains the following sections:

• About SOLD

• Acquiring and Installing the Acrobat Reader Software

• Verifying Your Adobe Acrobat Software

• Installing SOLD

• Verifying the SOLD Installation

• Configuring SOLD for Each User

• Searching SOLD on Linux

To ensure a successful installation, complete the following 
procedures before beginning the installation process:
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• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

The V-2003.12 version of SOLD contains documentation for the 
V-2003.12, U-2003.09, U-2003.06, and U-2003.03 releases of 
Synopsys tools. You can access the documentation by clicking the 
product name on the SOLD front panel.

About SOLD 

This chapter describes how to install and verify Synopsys Online 
Documentation (SOLD). The SOLD CD and the SOLD directory 
contain document files in the cross-platform Adobe Portable 
Document Format (PDF), as well as Portable Document Index files 
(PDX) that enable full-text searching across all SOLD documents.

To read and search these files, you need version 4.0 or later of 
Adobe Acrobat Reader with Search plug-in or Adobe Acrobat. You 
can download Acrobat Reader with Search plug-in free of charge 
from the Adobe Web site. For more information, see “Acquiring and 
Installing the Acrobat Reader Software” on page 23-3.

The online documentation for System Studio (System Studio SOLD) 
is distributed to System Studio customers on a separate CD. The 
installation instructions in this chapter apply to both SOLD and 
System Studio SOLD.
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Acquiring and Installing the Acrobat Reader Software

You can acquire the Acrobat Reader software by downloading the 
freeware Acrobat Reader from the Web.

Note:   
Windows users: Beginning with version 6.0, Acrobat Reader is 
called Adobe Reader.

Downloading and Installing Acrobat Reader from the 
Web

To download Acrobat Reader from the Acrobat Web site, 

1. Go to http://www.adobe.com/ and click the Get Acrobat Reader 
button. Follow the instructions on the Web page. 

2. Uncompress the tar.Z file or use the gunzip utility for the tar.gz 
file. For example,

% gzip -d sol-508.tar.gz

3. Untar the resulting file. For example,

% tar xvf sol-508.tar

4. Enter ./install to start the installation script. 

For more information, consult the ReadMe.html file or instguid.txt file 
that comes packaged with Acrobat Reader. 
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Verifying Your Adobe Acrobat Software

To view SOLD, you must have Acrobat Reader version 4.x or later.

To search SOLD, you must have the Search plug-in. For information 
about searching SOLD on the Linux platform, see “Searching SOLD 
on Linux” on page 23-10.

The following sections describe how to determine your current 
software configuration.

Checking the Version Number

If you are using 3.x or an earlier version of Acrobat, you must 
upgrade to view SOLD. Follow the instructions in “Acquiring and 
Installing the Acrobat Reader Software” on page 23-3.

To check the version number,

1. Open Acrobat Reader.

2. Choose Help > About Acrobat Reader (or Help > About Adobe 
Acrobat).

3. In the window that appears, verify that the words “Acrobat 
Reader 4.0” or “Adobe Acrobat 4.0” appear. (Later versions of 
Acrobat Reader are also supported.)

4. Close the About screen by clicking anywhere in the window.
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Checking for the Search Plug-In

If you are using Acrobat Reader without the Search plug-in, you must 
upgrade to have full-text searching capability in SOLD. The Search 
plug-in cannot be downloaded from the Adobe site as a separate file; 
to upgrade, you must download the entire Acrobat Reader with 
Search plug-in package. Follow the instructions in “Acquiring and 
Installing the Acrobat Reader Software” on page 23-3.

To check for the Search plug-in,

1. Open Acrobat Reader (if it is not already open).

2. Choose Help > About Plug-Ins or About Adobe Acrobat Plug-Ins 
to verify that Acrobat Search is on the list of installed plug-ins.

Installing SOLD

You can install SOLD by electronic software transfer (EST) or from 
the SOLD CD. 

Contents of SOLD

The SOLD documentation set contains PDF document files, the 
index (PDX) files that enable full-text searching, and the UNIX 
installation scripts. 

SOLD contains several collections of documents. Each collection 
describes a particular subject area and resides in its own directory. 
Each collection directory contains all the PDF files for the books in 
its subject area, as well as the index files for searching in that 
collection.
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The README.1ST file in the SOLD directory and on the SOLD CD 
lists the contents of SOLD.

Installation Options

There are two ways to install SOLD:

• As a stand-alone installation

• As an overlay installation, installed over an existing Synopsys 
installation directory

Note:   
You cannot install a stand-alone product over a stand-alone 
SOLD installation. To install SOLD and a stand-alone product 
together, install the product first, then install SOLD as an overlay 
installation.

The SOLD installation procedure copies files from the SOLD 
directory (for EST) or SOLD CD into the appropriate places in the 
Synopsys root directory structure.

SOLD offers the following installation options:

• Full installation on hard drive

• Partial installation on hard drive

• No installation on hard drive (read from CD)

The installation script performs a full installation. Most sites use a full 
installation for shared access by many users. If disk space is at a 
premium, you can create a partial installation by removing unused 
directories after the installation is complete (see “Partial Installation” 
on page 23-8).
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Installing SOLD CDs on HP-UX Platforms

When SOLD is installed on HP-UX platforms, the entire content of 
the CD is not copied to the disk. To copy all of SOLD, you must 
download and install the following patches before installing SOLD: 

For HP-UX 11.00
PHCO_26449, PHKL_26450, PHKL_28060

For HP-UX 11.11 (11.i)
PHKL_28025, PHKL_26269

To download the patches, go to http://itrc.hp.com. 

Electronic Software Transfer Installation

To download and install SOLD from the Web or by EST, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2. 

To access the complete collections of SOLD, download ssd1 and 
ssd2. The SOLD files use the following convention:

sold_V-2003.12_ssd1.tar.Z
sold_V-2003.12_ssd2.tar.Z

Two additional SOLD CDs are available: one for the Japanese 
version of SOLD and one specifically for System Studio customers.

• If you want to download only J-SOLD, download the 
sold_V-2003.12_jsd3.tar.Z file.

• To download only System Studio SOLD, download the 
sold_V-2003.12_ssd4.tar.Z file.
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Example 2-1 on page 2-10 shows a Synopsys media installation 
script for the synthesis tools. SOLD is installed in a similar manner. 

CD Installation

The SOLD collections are packaged on four CDs.Volume 1, 2, and 3 
are packaged together. Volume 4, System Studio SOLD, is packaged 
separately and is provided only to System Studio customers.

To install SOLD from the CD, follow the installation procedure 
described in “Mounting the CD” on page 2-8.

To access all documentation except for Japanese SOLD (J-SOLD on 
volume 3) and System Studio, copy the volume 1 and volume 2 CDs 
to your hard disk by running the install.now script. 

To install only J-SOLD, install the volume 3 CD 
(sold_V-2003.12_jsd3). 

To install only documentation for System Studio, install the System 
Studio Online Documentation CD (sold_V-2003.12_ssd4).

Example 2-1 on page 2-10 shows a Synopsys media installation 
script for the synthesis tools. SOLD is installed in a similar manner. 

Partial Installation

Because each collection directory is self-contained, partial 
installations of SOLD are possible. 

To effect a partial installation of SOLD, perform a standard 
installation, then delete from $SYNOPSYS/doc/online those 
collection directories you do not need at your site.
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Note:   
Do not delete the top.pdf file; it contains the SOLD front panel, 
which lists the products that are documented. Do not delete the 
solid directory; it contains the SOLD User Guide.

Keep the remaining collection directories intact: Do not remove files 
from them or move the files in a collection relative to each other. 
Such modifications can cause hypertext links and the search 
mechanism to fail.

Verifying the SOLD Installation

Verify the installation by opening SOLD. To open SOLD, issue the 
command

% $SYNOPSYS/sold

If SOLD is correctly installed, this command invokes Acrobat and 
displays the SOLD welcome screen in the Acrobat window.

Configuring SOLD for Each User

The search engine uses index files to perform full-text search and 
retrieval on a document. SOLD provides an index file (index.pdx) 
with each collection. 

When you open a document, the associated index file is 
automatically available to the search engine. However, to search 
SOLD before opening a document, you can manually make an index 
available to the search engine.
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To manually make an index available to the search engine,

1. Choose Edit > Search > Select Indexes in the Acrobat window. 

2. Click the Add button.

3. Navigate to one of the collection directories, for example, 
$SYNOPSYS/doc/online/synth.

4. Select the index.pdx file.

5. With the index.pdx file selected, click the Apply button.

The selected index is added to the list of available indexes.

For information about using SOLD, see the SOLD User Guide. To 
access the SOLD User Guide, open SOLD and click the hypertext 
link labeled “Using Synopsys Online Documentation.”

Searching SOLD on Linux 

Only the Find command (Edit > Find) is available for searching the 
Linux version of SOLD. To locate information with the Find 
command, use the print version of a document. From the SOLD front 
page, select a document set, then click the print version icon ( ) 
next to the document you want. 
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This chapter contains the following sections:

• Memory

• X Window System
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Memory

Some common memory problems and possible solutions are 
described in this section.

Why Do I Get an “out of memory” Message?

Here is a possible scenario: A large job is running on a machine that 
has abundant swap space. You try to run a Design Compiler job on 
this machine and assume that you don’t need to be concerned about 
running out of swap space. But the application terminates with a fatal 
out-of-memory message before the machine runs out of swap 
space.

UNIX limits the amount of memory a job or process can consume 
while it is running. If a job reaches these limits before the system 
runs out of swap space, the job terminates with the fatal 
out-of-memory error message. These limits are built into the UNIX 
OS to prevent a single job or process from consuming all system 
resources (swap space, CPU time, number of processes, and so on), 
thereby depleting resources for other jobs. Some limits applicable to 
Synopsys applications are

• Data size—The maximum data size (including stack) for the 
process

• CPU time—The maximum CPU seconds per process

• Core dump size—The maximum size of a core dump

The data-size limit is the most important. It can be set at two levels:

• The system level
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Limits are enforced for everyone who runs on that system.

• On a per-user basis

On all machines except those running HP-UX, you can change 
your personal limits by using the limit command (C shell) or  
ulimit -s -d command (Bourne, Korn, or Bash shell). On the 
HP-UX platform, only the system administrator can set the limits. 
Personal limits cannot exceed the systemwide limit. For example, 
the limits on a Sun client (Solaris 8) might look like this:

% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited

Note:   

In this example, any jobs or processes started on the Sun 
client can grow to 524 MB before limits are enforced. 

On some solaris systems, setting the data size to unlimited 
defaults to a data size of only 2 GB. To set a larger data size, 
set the data size explicitly. For example, set it to 3.8 GB by 
using the following command:

% limit datasize 3891 MB

If the data size is sufficient, check the stack size. A stack size that is 
larger than the default (8,192 KB) can cause the data size to be 
smaller than required. Because the stack size is taken at the 
beginning of the process, it uses memory that would normally be 
available for data. Therefore you should set the stack size higher 
than the default only when absolutely necessary. 
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Most system administrators do not adjust the limits unless they are 
confronted with problems. If you do not adjust the limits, it is possible 
for a tool requiring a lot of swap space (such as Design Compiler) to 
experience an out-of-memory problem.

Note, however, that it is possible to extend memory (physical and 
swap space). For more information, see “Accessing Memory Beyond 
2 GB With 32-Bit Synopsys Tools” on page 1-13.

What Should I Do When an “out of memory” Error 
Occurs?

Make sure that you are not running out of swap space on the system. 
Use the swap -l command for Sun SPARC systems to obtain swap 
space information. For example,

  % swap -l
  swapfile           dev   swaplo  blocks   free
  /dev/dsk/c0t3d0s1  32,25      8  822520   628872

To determine available swap space on systems other than Sun 
SPARC, contact your system administrator. 

If you have enough swap space but still encounter OS limits, use the 
limit command to find out what the datasize variable is set to 
(for all machines except HP). The limit command displays 
user-level limits.

% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited
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If your user-level data-size limit is too low, you can increase it by 
entering limit datasize xxxxm  at the UNIX prompt, where xxxx 
is the number of megabytes and m stands for megabytes. For 
example,

% limit datasize 3891m

Note:   
The limit command is a built-in C shell (csh) command. Make 
sure you are in csh before you execute limit. 

For additional information about the limit command, see the 
appropriate man page. On HP systems you cannot change the 
user-level limits. User-level limits can be changed only at the system 
level.

The procedure for making limit changes varies from platform to 
platform. The system administrator at each site should be familiar 
with the procedure. If you still encounter problems, contact your 
ncuSynopsys technical representative.

X Window System

Some common X Window System problems and possible solutions 
are the following:

• If you cannot use the vi text editor in the xterm window, add an 
xterm entry in your /etc/termcap file.
24-5

Troubleshooting



• If, after an upgrade, you can no longer open Design Analyzer 
from your host, verify that the fonts assigned in 
.synopsys_dc.setup or the server default fonts are loaded. A fatal 
error results if the fonts are not available.

• Your ~/.xinitrc script might not be read on startup because it is a 
C shell script. In this case, you must rewrite it as a Bourne (/bin/
sh) script.
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Part II: Physical Implementation

Astro, Astro Interactive Ultra, JupiterXT, and Columbia

Astro-Rail

Hercules

HSPICE

Star-RCXT

StarSim-XT

TCAD
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JupiterXT, and Columbia 25

Note:   
The installation instructions in this chapter are the most 
up-to-date available at the time of production. However, changes 
might have occurred. For the latest installation information, see 
the product release notes or documentation. 

The tool versions for this release are

• Astro version U-2003.09

• Astro Interactive Ultra version U-2003.09

• JupiterXT version U-2003.09

• Columbia version V-2003.12
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This chapter contains the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting Up Astro for a New User

• Verifying the Astro Installation

Media Availability and Supported Platforms

The U-2003.12 version of the Astro tool is available on CD or by FTP 
download. Obtain the appropriate binary executable files based on 
the operating system you need. Table 25-1 shows the supported 
platforms for the U-2003.12 release.

Table 25-1 Supported Operating Systems and Platform Keywords

Operating system Platform keyword

Solaris 8 SUN.32, SUN.64

HP-UX 11.0, 11i HP.64

Red Hat Linux 7.2 IA.32
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Installing the Software

The steps in this procedure describe how to install Astro on the Red 
Hat Linux 32-bit platform. For other platforms, use the appropriate 
file name and platform for the tool you want to install.

To install the Astro software on your server,

1. Change directory to the installation directory by entering

% cd install_dir

where install_dir is the directory where you want to install the 
software. 

2. Examine the contents of your directory.

% ls /cdrom/volume_name

You should see the following file:

 /cdrom/volume_name/U-2003.09.astro.ia.32.tar.gz

3. Unzip the file.

% gzip -dc /cdrom/volume_name/U-2003.09.astro.ia.32.tar.gz | tar  -vxf -

4. Change to the bin directory. For example,

% cd bin/ia.32

5. Copy the Synopsys license daemon to the /etc directory:

% cp -p avantd /etc

6. Create a license directory.

% mkdir /usr/local/flexlm /usr/local/flexlm/licenses
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7. Copy the license to the license directory.

% cp source_dir/license.dat /usr/local/flexlm/licenses

where source_dir is where the license.dat (and package.dat) file 
resides.

8. Start the license server.

% install_dir/bin/ia.32/lmgrd -c /usr/local/flexlm/licenses/ \
    license.dat -l /usr/local/flexlm/licenses/license.log

9. To automatically start the license server whenever you reboot the 
server, add the following line to the /etc/rc.local file:

% install_dir/bin/ia.32/lmgrd -c /usr/local/flexlm/licenses/ \
    license.dat -l /usr/local/flexlm/licenses/license.log

where install_dir is the directory where you installed the software. 

For more information about the license server, see 
www.synopsys.com/keys or the FLEXlm End User Manual.

Setting Up Astro for a New User

This section describes how to set up a local machine for Solaris so 
that it can access the Synopsys software. Perform this procedure for 
each machine on the network.

1. To set up your machine, update your environment variables by 
adding the following variables in your .cshrc file:

setenv LM_LICENSE_FILE /usr/local/flexlm/licenses \
 /license.dat:$LM_LICENSE_FILE
set path = (install_dir/bin/platform $path)
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where install_dir is the directory in which the Synopsys software 
is installed and platform is the appropriate platform.

2. Update your path variable by entering 

% source .cshrc

Make sure the XKeysymDB file resides in or is linked from /usr/
lib/X11.

Verifying the Astro Installation

To verify the Astro installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering the following command: 

% Astro

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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Note:   
The installation instructions in this chapter are the most 
up-to-date available at the time of production. However, changes 
might have occurred. For the latest installation information, see 
the product release notes or documentation. 

This chapter contains the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting Up Astro-Rail for a New User

• Verifying the Astro-Rail Installation
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Media Availability and Supported Platforms

Astro-Rail is available on CD or by FTP download. Obtain the 
appropriate binary executable files based on the operating system 
you need. Table 26-1 shows the supported platforms for the 
V-2003.12 release.

Installing the Software

The steps in this procedure describe how to install Astro-Rail on the 
Sun Solaris 64-bit platform. For other platforms, use the appropriate 
file name and platform for the tool you want to install.

To install the Astro-Rail software on your server,

1. Change directory to the installation directory by entering

% cd install_dir

where install_dir is the directory where you want to install the 
software. 

Table 26-1 Supported Operating Systems and Platform Keywords

Operating system Platform keyword

Solaris 8, 9 SUN.32, SUN.64

HP-UX 11.0, 11i HP.64

Red Hat Linux 7.2 IA.32
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2. Examine the contents of your directory.

% ls /cdrom/volume_name

You should see the following file:

 /cdrom/volume_name/astrorail_V-2003.12_SUN.64.tar.gz 

3. Unzip the file.

% gzip -dc /cdrom/volume_name/astrorail_V-2003.12_SUN.64.tar.gz | tar  -vxf -

4. Change to the bin directory. For example,

% cd bin/SUN.64

5. Copy the Synopsys license daemon to the /etc directory.

% cp -p avantd /etc

6. Create a license directory.

% mkdir /usr/local/flexlm /usr/local/flexlm/licenses

7. Copy the license to the license directory.

% cp source_dir/license.dat /usr/local/flexlm/licenses

where source_dir is the location of the license.dat (and 
package.dat) file.

8. Start the license server.

% install_dir/bin/SUN.64/lmgrd -c /usr/local/flexlm/licenses/ \
    license.dat -l /usr/local/flexlm/licenses/license.log
26-3

Installing Astro-Rail (version V-2003.12)



9. To automatically start the license server whenever you reboot the 
server, add the following line to the /etc/rc.local file:

% install_dir/bin/SUN.64/lmgrd -c /usr/local/flexlm/licenses/ \
    license.dat -l /usr/local/flexlm/licenses/license.log

where install_dir is the directory where you installed the software. 

For more information about the license server, see 
www.synopsys.com/keys or the FLEXlm End User Manual.

Setting Up Astro-Rail for a New User

This section describes how to set up a local machine for Solaris so 
that it can access the Synopsys software. Perform this procedure for 
each machine on the network.

To set up your machine,

1. Update your environment variables by adding the following 
variables in your .cshrc file:

setenv LM_LICENSE_FILE /usr/local/flexlm/licenses \
 /license.dat:$LM_LICENSE_FILE
set path = (install_dir/bin/platform $path)

where install_dir is the directory in which the Synopsys software 
is installed and platform is the appropriate platform.

2. Update your path variable by entering 

% source .cshrc

Make sure the XKeysymDB file resides in or is linked from
 /usr/lib/X11.
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Verifying the Astro-Rail Installation

To verify the Astro-Rail installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering

% AstroRail

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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Installing Hercules (version V-2003.12) 27

Note:   
The installation instructions in this chapter are the most 
up-to-date available at the time of production. However, changes 
might have occurred. For the latest installation information, see 
the product release notes or documentation. 

This chapter contains the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting the Environment Variables

• Setting Up Hercules for Each User

• Verifying the Hercules Installation
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Media Availability and Supported Platforms

The Hercules and Hercules-Explorer tools are available on CD or by 
EST download. Obtain the appropriate binary executable files based 
on the operating system you need. Table 27-1 shows the supported 
platforms for the V-2003.12 release.

Table 27-1 Supported Operating Systems and Platform Keywords

Operating system Platform keyword

Solaris 8 SUN32_58, SUN64_58

HP-UX 11.0 HP32_U11, HP64_U11

Red Hat Linux 7.2 IA32_L24

Red Hat Advanced Server 2.1 IA64_L24

AIX 5.11 RS64_AIX51

Amd Opteron (RHEL v31) 

1. The AIX 5.1 and Red Hat Enterprise Linux platforms are not available on CD. They will be 
available for download by electronic software transfer (EST) at a later date. For availability, check 
with your Synopsys sales representative.

amd64 (64-bit mode) 
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Installing the Software

The steps in the following procedure describe how to install Hercules 
on the Sun Solaris 32-bit platform. The procedure for other platforms 
is similar.

Before you begin the installation, 

• Make sure you have enough disk space for Hercules and 
Hercules-Explorer installation. For a full installation on one 
platform, 120 MB is recommended.

• To install Synopsys tools, it is recommended that you log on as 
root or have system administrator privileges. You need write 
permission for the installation directory.

Note:   
The Hercules software is configured so that multiple platforms of 
this version can be installed in a single installation directory 
(install_dir ).

To install the Hercules software on your server,

1. Create a Hercules installation directory if one does not already 
exist. For example,

% mkdir -p /usr/synopsys/hercules

In the rest of this chapter, this directory path is referred to as 
install_dir. 

2. Download the Hercules release to the installation directory. 

You can get the latest Hercules download instructions from the 
SolvNet Release Library.
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3. Uncompress and untar the files.

% gzip -dc hercules-version-platform.tar.gz | tar xvf -

This command creates a subdirectory in the Hercules installation 
directory. For example, 

% /usr/synopsys/hercules/necessary_files_and_directories

In the remainder of this chapter, this subdirectory is referred to as 
the Hercules installation directory.

4. To set the file permissions on the new directory tree and its 
contents, enter

% chmod -R 755 install_dir

5. Remove the hercules-version-platform.tar.gz file.

% rm hercules_version_platform.tar.gz
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Setting the Environment Variables

This section discusses the following environment variables:

• $HERCULES_HOME_DIR

• $LM_LICENSE_FILE

It is recommended that you place these variables in your $HOME/
.cshrc or $HOME/.profile file as your default settings. 

Setting the $HERCULES_HOME_DIR Environment 
Variable

Follow these steps.

1. Set the $HERCULES_HOME_DIR environment variable by 
replacing TOP-LEVEL-INSTALL-DIR in 
install_dir/hercules_setup.csh and install_dir/hercules_setup.sh 
files with install_dir.

2. Update your environment by entering the following lines:

- If you are using the C shell, enter

% source .cshrc

- If you are using the Bourne shell, enter

% . .profile
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Setting the $LM_LICENSE_FILE Environment Variable

The $LM_LICENSE_FILE environment variable defines the full path 
name to the location where the license files have been loaded on 
your machine. 

To enable Hercules to check out a license, set the 
$LM_LICENSE_FILE environment variable. For example,

• If you are using the C shell, add the following line:

setenv $LM_LICENSE_FILE port@hostname

• If you are using the Bourne shell, enter these lines:

set $LM_LICENSE_FILE=port@hostname
export $LM_LICENSE_FILE

The port and host name variables correspond to the TCP port and 
license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@host rather than using the path to 
the license file.

Each license file can contain licenses for many packages from 
multiple vendors. You can specify multiple license files by separating 
each entry with a colon (:).

Note:   
To obtain your license key file from SmartKeys, go to the 
SmartKeys Web page at 

http://www.synopsys.com/smartkeys
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Setting Up Hercules for Each User

To set up a new user, you must

• Source the .cshrc or . kshrc files

• Enter the path information

• Set up a license variable that points to the license server

It is recommended that the following information be added to the 
.cshrc, .kshrc, or a Hercules source file:

1. Add the Hercules executable files to your search path.

- If you are using the C shell, enter

set path=(install_dir/bin/platform $path)

- If you are using the Bourne shell, enter

PATH=install_dir/bin/platform: $PATH
export PATH

2. Set the following licensing variable:

LM_LICENSE_FILE
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Verifying the Hercules Installation

To verify the Hercules installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

2. Invoke the tool by entering 

% hercules -V

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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28
Installing HSPICE (version U-2003.09) on 
UNIX or Windows Platforms 28

Note:   
The installation instructions in this chapter are the most up-to-
date available at the time of production. However, changes might 
have occurred. For the latest installation information, see the 
product release notes or documentation. 

This chapter includes the following sections:

• Media Availability and Supported Platforms

• Installing the Software on UNIX or Linux Platforms

• Configuring HSPICE and AvanWaves for UNIX and Linux

• Setting Up HSPICE and AvanWaves for Each User

• Verifying the HSPICE and AvanWaves Installation
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• Installing the Software on Windows Platforms

• Related Documentation and Customer Support

Media Availability and Supported Platforms

HSPICE, Interface, AvanWaves, and Metaencrypt are available on 
CD and by EST download on all platforms, with the following 
exceptions:  

• Interface is not available on Linux, Dec Alpha, SGI, or Windows 
platforms.

• AvanWaves is not available on the Linux platform.

Obtain the appropriate binary executable files for your operating 
system.  Table 28-1 lists the supported platforms for this release. 

Table 28-1 Platforms and Keywords

Operating system Synopsys platform keywords

HP-UX 10.20, 11.0, hp32 (32-bit mode)  
hp64 (64-bit mode)

Solaris  2.5, 8 sparcOS5 (32-bit mode)
sparc64 (64-bit mode)

Red Hat Linux 6.2, 7.2 linux (32-bit mode)

AIX 4.3. rs6000

Windows NT, 2000, XP winnt,  win2000,  winxp

SGI IRIX 6.5.1 sgimips

DEC Alpha OSF 4.0 alpha 
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Note:   
When you use HSPICE with Windows platforms that use AMD 
Athlon CPUs, only a single processor is supported.

Installing the Software on UNIX or Linux Platforms

To install HSPICE and AvanWaves from the CD,

1. Make sure you have enough disk space for HSPICE and 
AvanWaves installation. For a full installation on one platform, 
120 MB is recommended.

2. To load the software, enter 

% path_to_cdrom/install_dir/synopsys_install

The Synopsys Installation Program dialog box appears. 

3. Enter the name of the installation directory in which you want to 
load the products.

4. Select the products and platforms that you want to load, and then 
click Load.

5. After the loading is completed, click Exit.

Note:   
If you have problems reading the CD on the Solaris 7 platform, 
contact Sun to obtain OS patch version 107465-04 or later 
(/kernel/fs/hsfs/patch). 

To install HSPICE and AvanWaves by electronic software transfer,

1. If necessary, create an HSPICE installation directory. For 
example,
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% mkdir -p /usr/synopsys/hspice

2. Change to the HSPICE installation directory.

% cd /usr/synopsys/hspice

3. Download the HSPICE binary files to the installation directory. 

You can get the latest HSPICE download instructions from the 
SolvNet Release Library.

4. Uncompress and untar the files.

% cd /usr/synopsys/hspice

% gzip -dc hspice_version_platform.tar.gz | tar xvf - 

If you don’t want to see the list of unpacked files, omit the v from 
xvf -. For other methods of handling tar files,  See “Performing 
EST Installation” on page 2-6.

Note:   

This creates a subdirectory in the HSPICE installation 
directory. For example, 

/usr/synopsys/hspice/version

In the remainder of this chapter, this subdirectory is referred to 
as the installation directory or $installdir.

5. To set the file permissions on the new directory tree and its 
contents, enter

% chmod -R 755  /usr/synopsys/hspice

6. Remove the hspice-version-platform.tar.gz file.

% rm hspice_version_platform.tar.gz

7. Configure HSPICE and AvanWaves for your site.
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8. Verify the HSPICE and AvanWaves installations.

9. For each user, set the required environment variables.

To configure the tools, verify the installations, and set the 
environment variables for each user, see the following sections. 

Configuring HSPICE and AvanWaves for UNIX and 
Linux

To configure HSPICE and AvanWaves for UNIX and Linux platforms,

1. Verify the platform on which you want to configure the products.

2. Invoke the configuration program by entering

% installation_directory/bin/config

The Configure Products dialog box appears.

3. If you want to configure AvanWaves, select Configure 
AvanWaves. 

No option is required.

4. If you want to configure HSPICE, select Configure HSPICE. 

The configuration options are “versions file...,” “meta.cfg file ...,” 
“hspice.ini file ...,” and setup buttons. If you do not select these 
options, the default settings apply. 

5. After selecting your options, click the Configure button. 

The configuration log is shown in the middle of the dialog box.

6. Click Exit when the configuration has finished.
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Setting Up HSPICE and AvanWaves for Each User

To set up a new tool user, 

• Enter the path information.

• Set up a license variable that points to the license server.

• Source the cshrc.meta file, or use a dot (.) with the kshrc.meta file 
(where .  is a Bourne or Korn shell command).

Add the following information to the cshrc, . kshrc, or an HSPICE 
source file:

1. Add the HSPICE and AvanWaves executable files to your search 
path.

- If you are using the C shell, enter

set path=(installation_directory/bin $path)

- If you are using the Bourne or Korn shell, enter

PATH=installation_directory/bin:$PATH

2. Set one of the following licensing variables:

LM_LICENSE_FILE

or

AVANTD_LICENSE_FILE

For example,

- If you are using the C shell, add the following line:

setenv LM_LICENSE_FILE port@hostname
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- If you are using the Bourne or Korn shell, enter these lines:

set LM_LICENSE_FILE=port@hostname
export LM_LICENSE_FILE

3. Source the cshrc.meta or .kshrc.meta file.

- For C shell users, enter

% source installation_directory/bin/cshrc.meta

- For Bourne or Korn shell users, enter

$ . installation_directory/bin/kshrc.meta

Verifying the HSPICE and AvanWaves Installation

After you set up the licensing and HSPICE software packages, do 
the following:

• For C shell users, enter

% source installation_directory/bin/cshrc.meta  

• For Bourne or Korn shell users, enter

$ . installation_directory/bin/kshrc.meta

If this step fails, or if the cshrc.meta file does not exist, the installation 
program failed. To find the problem, review the installation log file:

 installation_directory/bin/synopsys_config.log_pid
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Verifying the HSPICE Installation

To verify the HSPICE installation,

1. Make sure you are in a directory where you have read/write 
privileges.

% cd $HOME

The $installdir environment variable refers to the HSPICE 
installation directory. This variable is created when you source 
the cshrc.meta file.

2. To run a demonstration simulation, enter

 % hspice $installdir/demo/hspice/bench/demo.sp > 
demo.lis

3. To view the simulation output, enter

% vi demo.lis

4. If you are able to get a license, you will see a message about 
licenses near the top of the listing. 

lic: Checkout hspice; Encryption code: xxx

If you get a ***** job concluded statement near the bottom 
of the listing, the simulation was successful.
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Verifying the AvanWaves Installation

To verify the AvanWaves installation,

1. Change to the installation directory.

% cd $installdir/bin/

The $installdir environment variable refers to the 
AvanWaves installation directory. This variable is created when 
you source the cshrc.meta file.

2. To start AvanWaves, enter 

% awaves &   

Installing the Software on Windows Platforms

This section describes how to install and set up the license server for 
HSPICE on a PC. To run HSPICE, your system must have

• A Pentium or compatible processor or later

• At least 64 MB of memory (128 MB or more is recommended)

• A parallel port for the security key (if you are using a dongle-
based license)

• Windows NT, Windows 2000, or Windows XP operating system

• Approximately 100 MB of free disk space for a full installation of 
HSPICE, AvanWaves, and MetaEncrypt
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Installing With Windows Explorer

To install HSPICE by using Windows Explorer,

1. Insert the HSPICE CD into the CD drive.

2. In Windows Explorer, double-click the CD drive icon.

3. Double-click the pchspice folder icon.

4. Double-click the Setup application icon.

5. To install the software, follow the screen prompts.

Installing With Windows DOS Shell

To install HSPICE by using the Windows DOS shell,

1. Insert the HSPICE CD into the CD drive.

2. At the DOS shell command prompt, enter

c:\> CD-ROM drive letter:\pchspice\setup.exe

3. To install the software, follow the screen prompts.

Installing the Sentinel System Drivers

Installation of Sentinel drivers is required only when you use dongle-
based licenses. For information about the Win32 sentinel_key driver 
(dongle key), see the README.txt file located in the %installdir% 
installation directory. 

In Windows Explorer,
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1. Double-click  the %installdir%\DRIVERS\flexid.exe file to install 
the driver. 

2. Set the LM_LICENSE_FILE environment variable.

This variable is normally set in the Control Panel. (For Windows 
NT, choose Control Panel > System > environment. For Windows 
2000 or WindowsXP, choose Control Panel > System > 
Environment Variables.)

LM_LICENSE_FILE=path_to_license_file

For detailed information about the FLEXlm licensing, see the 
FLEXlm End User Manual.

Note:   
If you have multiple dongles connected to each other, the 
Synopsys dongle must be connected directly to the PC.

Running HSPICE on Windows

You can run HSPICE in any of the following ways:

• Double-click the HSPUI icon and then click the Simulate button.

• Double-click the HSPICE icon. You are prompted to enter names 
for the input netlist file and output list files. If you do not name an 
output file, all of the .lis, .st0, and .tr0 files will be written in the 
directory in which you run HSPICE or hspice.exe.

• At the DOS prompt in Windows, enter

c:\> cd work_directory
c:\> %installdir%\BIN\HSPICE -i netlist -o listfile 
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Running AvanWaves on Windows

Start AvanWaves in any of the following ways:

• Double-click the HSPUI icon and then click the AvanWaves 
button.

• Double-click the AvanWaves icon.

• At the DOS prompt in Windows, enter

c:\> %installdir%\BIN\AWAVES

Important:   
If you start AvanWaves by using a method other than selecting 
the HSPUI icon and then you open online Help, you must delete 
the Galaxy Help Server task from the Task Manager after you exit 
AvanWaves. Otherwise the next invocation of HSPICE can have 
a memory conflict with the AvanWaves Galaxy Help server.

Running Older Versions of HSPICE

You can use the HSPUI utilities to run different versions of HSPICE 
that are already installed on your computer. In the installation 
directory (%installdir%), the versions.txt file contains all the 
information about different versions of HSPICE.

An example of a versions.txt file follows:

<BOF>
  c:\avanti\Hspice2001.2\BIN\hspice.exe    HSPICE 2001.2
  c:\avanti\Hspice2002.2\BIN\hspice_mt.exe HSPICE 2002.2
<EOF>
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You can add different HSPICE executable file full paths to 
subsequent lines in the versions.txt file. The second column contains 
comments as a version reminder and is ignored by the HSPUI utility. 
After invoking HSPUI, you can select the HSPICE version in the 
combo box of the HSPUI window. HSPICE will run according to the 
path selected in the combo box.

The following executable files are provided on the HSPICE, 
AvanWaves, and Utility disks:

*.EXE File
%installdir%\bin\lmutil (lmutil hostid - sentinel; run from 
the DOS prompt)
\%installdir%\bin\hspice (HSPICE executable running in a PC 
Windows environment)
%installdir%\bin\awaves (AvanWaves executables running in a 
PC Windows environment)
%installdir%\bin\hspui (GUI utility that launches HSPICE.EXE 
and AWAVES.EXE)

The hspice.ini File 

On Windows platforms, the hspice.ini file is the configuration file that 
contains HSPICE options such as the search path. For example, 

.Option Post =1

.Op

.Option Post_version = 9601

..................

If you have installed more than one version of HSPICE on the same 
PC, more than one hspice.ini file will exist, but only one takes effect 
when you start the tool. 

The %installdir%\meta.cfg file points to the current hspice.ini file.
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Related Documentation and Customer Support  

 For documentation about using HSPICE and AvanWaves, see the 

• AvanWaves User Guide

• Device Models Quick Reference Guide

• Elements and Device Models Manual

• HSPICE Applications Manual

• HSPICE Quick Reference Guide

• HSPICE Signal Integrity Guide

• HSPICE Simulation and Analysis User Guide

• MOSFET Models Manual

All documentation is available on SOLD or through Documentation 
on the Web. Print versions are available only for the HSPICE Quick 
Reference Guide and the Device Models Quick Reference Guide. 
For information about accessing the documentation, see “Related 
Publications” on page xix. 

For information about contacting Customer Support, see “Customer 
Support” on page xxi.    

If you cannot solve a problem, use an editor to review the following 
files for system error messages:

• /tmp/pid/synopsys_install.log_pid (which is generated during 
installation)

• /tmp/pid/synopsys_config.log_pid (which is generated during 
configuration)
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Note:   
The installation instructions in this chapter are the most up-to-
date available at the time of production. However, changes might 
have occurred. For the latest installation information, see the 
product release notes or documentation. 

This chapter includes the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting Up Star-RCXT for Each User

• Verifying the Star-RCXT Installation

• Customer Support
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Media Availability and Supported Platforms

Star-RCXT is available on CD or by EST download. Obtain the 
appropriate binary executable files based on the operating system 
you need. Table 29-1 shows the supported platforms for the 
V-2003.12 release.

Installing the Software 

To install Star-RCXT,

1. Create a Star-RCXT installation directory if one does not already 
exist. For example,

% mkdir -p /usr/synopsys/star-rcxt

2. Change to the Star-RCXT installation directory. 

% cd/usr/synopsys/star-rcxt

3. Download the Star-RCXT binary files to the installation directory.

You can get the latest Star-RCXT download instructions from the 
SolvNet Release Library.

Table 29-1 Supported Operating Systems and Platform Keywords

Operating System Platform keyword

Solaris 5.7+ Sun.32, Sun.64

HP-UX B.11.00+ HP.32, HP.64

Red Hat Linux 7.2

Red Hat Linux Advanced Server 2.1

IA.32

IA.64
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4. Uncompress and untar the files. For example,

    % gzip -dc platform_star-rcxt-version.tar.gz | tar xvf -

Substitute the appropriate platform keyword for platform. (See 
“Media Availability and Supported Platforms” on page 29-2.)

Note:   

This command will create a subdirectory in the Star-RCXT 
installation directory. For example, 

/usr/synopsys/star-rcxt/platform_star-rcxt 

5. To set the file permissions on the new directory tree and its 
contents, enter

% chmod -R 755 /usr/synopsys/star-rcxt

6. Remove the platform_star-rcxt-version.tar.gz file.

% rm platform_star-rcxt-version.tar.gz
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Setting Up Star-RCXT for Each User

To set up a new tool user, each user must

• Source .cshrc or . kshrc

• Enter the path information

• Set up a license variable that points to the license server

It is recommended that the following information be added to the 
.cshrc, .kshrc, or an Star-RCXT source file:

1. Add the Star-RCXT executable files to your search path.

- If you are using the C shell, 

set path=(installation_directory/bin $path)

- If you are using the Bourne shell,

PATH=installation_directory/bin:$PATH
export PATH

2. Set the following licensing variable:

LM_LICENSE_FILE
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Verifying the Star-RCXT Installation

To verify the Star-RCXT installation, 

1. Make sure you are in a directory with read/write privileges.

% cd $HOME

2. Run the Star-RCXT GUI on each installed platform by entering 
the following command:

% StarXtract -gui

The GUI will appear on your screen.

3. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

For information about using Star-RCXT, see the Star-RCXT User 
Guide. 

For information about accessing Star-RCXT documentation, see 
“Related Publications” on page xix. 

For information about contacting Customer Support, see “Customer 
Support” on page xxi.
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30
Installing StarSim-XT (version V-2003.12)30

This chapter contains the following sections: 

• Media Availability and Supported Platforms

• Downloading and Installing the Software

• Setting the Environment Variables

• Verifying the StarSim-XT Installation

• Customer Support
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Media Availability and Supported Platforms

StarSim-XT is available on CD or by EST download. Obtain the 
appropriate binary executable files based on the operating system 
you need. Table 30-1 shows the supported platforms for the 
V-2003.12 release.

Downloading and Installing the Software

To download and install StarSim-XT, 

1. Create a StarSim-XT installation directory if one does not already 
exist. For example,

% mkdir -p /usr/synopsys/starsimxt

2. Download the StarSim-XT release to the installation directory. 

You can get the latest StarSim-XT download instructions from the 
SolvNet Release Library.

3. Uncompress and untar the files:

% gzip -dc starsimxt_version_platform.tar.gz | tar xvf -

Table 30-1 Supported Operating Systems and Platform Keywords

Operating system Platform keyword

Solaris 7, 8
(Solaris 5.5, 5.6 are also supported)

sparcOS5
sparc64

HP-UX 11.0, 11i
(HP-UX 10.2 is also supported)

hp32
hp64

Red Hat linux 7.2
(Red Hat linux 7.1 is also supported)

linux
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This command creates a subdirectory in the StarSim-XT 
installation directory. For example, 

/usr/synopsys/starsimxt/starsimxt_version_platform

In the remainder of this chapter, this subdirectory is referred to as 
the StarSim-XT installation directory.

4. To set the file permissions on the new directory tree and its 
contents, enter

% chmod -R 755  /usr/synopsys/starsimxt

5. Remove the starsimxt_version_platform.tar.gz file.

% rm starsimxt_version_platform.tar.gz

6. For each user, set the required environment variables, as 
described in the next section.

Setting the Environment Variables

This section discusses the following environment variables:

• starsimxt_HOME

• LM_LICENSE_FILE

It is recommended that you place these variables in your 
$HOME/.cshrc or $HOME/.profile file as your default settings. 
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Setting the $starsimxt_HOME Environment Variable

Follow these steps.

1. Set the $starsimxt_HOME environment variable to point to your 
StarSim-XT installation directory.

- If you are using the C shell, enter

% setenv starsimxt_HOME starsimxt_installation_directory_path

- If you are using the Bourne shell, enter 

% setenv starsimxt_HOME=starsimxt_installation_directory_path
 EXPORT starsimxt_HOME

2.  Add $starsimxt_HOME/bin to your search path.

- If you are using the C shell, enter

set path=($starsimxt_HOME/bin $path)

- If you are using the Bourne shell, enter

PATH=$starsimxt_HOME/bin:$PATH
export PATH

Setting the LM_LICENSE_FILE Environment Variable

To enable StarSim-XT to check out a license, you must
set the LM_LICENSE_FILE environment variable. For example,

• If you are using the C shell, enter the following line:

setenv LM_LICENSE_FILE port@hostname

• If you are using the Bourne shell, enter these lines:

set LM_LICENSE_FILE=port@hostname
export LM_LICENSE_FILE
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The port and host name variables correspond to the TCP port and 
license server hostname specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use port@hostname rather than using the 
path to the license file.

Each license file can contain licenses for many packages from 
multiple vendors. You can specify multiple license files by separating 
each entry with a colon (:).

Verifying the StarSim-XT Installation

To verify the StarSim-XT installation, 

1. Make sure you are in a directory with read/write privileges.

% cd $HOME

2. To run StarSim-XT, enter 

% star_simxt filename

where filename is the name of your netlist. For example,

% star_simxt ckt.in

StarSim-XT directs the simulation output to an ASCII text file named 
ckt.lis. If you specified the HTML keyword in the configuration file, 
StarSim-XT directs the output to a file named ckt.html. 
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Customer Support

A new e-mail alias has been created for Star-SimXT users. To 
subscribe to this mailing list, send an e-mail to 
starsim-user-request@synopsys.com, and include subscribe in the 
body of the e-mail. To unsubscribe, type unsubscribe.

For information about using StarSim-XT, see the Star-Sim XT User 
Guide. To find out how to access StarSim-XT documentation, see 
“Related Publications” on page xix.

For information about contacting Customer Support, see “Customer 
Support” on page xxi.
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Installing TCAD Products and Utilities 31

Note:   
The installation instructions in this chapter are the most 
up-to-date available at the time of production. However, changes 
might have occurred. For the latest installation information, see 
the product release notes or documentation in SolvNet. 

For tool versions for this release, see Table 31-2 on page 31-3.

This chapter includes the following sections:

• Supported Platforms and Media Availability

• Installing TCAD Products

• Setting the User Environment to Find the TCAD License

• Running TCAD Products

• Using Graphics Devices
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• Troubleshooting

• TCAD Utilities

Supported Platforms and Media Availability 

Table 31-1 lists the supported platforms, operating systems, and 
corresponding Synopsys platform keywords for this release. For 
detailed information, see “Supported Platforms and Operating 
Systems” on page 1-2. 

TCAD products are available on CD or by FTP download. Obtain the 
appropriate binary executable files for your operating system.    

Table 31-1 Supported Platforms, Operating Systems, and Keywords

Platform Operating system Synopsys platform keywords Window 
environment

HP HP-UX 11.0, 11 hp32 (32-bit mode) CDE

Sun Solaris 8, 9 sparcOS5 (32-bit mode)
sparc64 (64-bit mode)

CDE

IBM AIX 4.3.3 rs6000 CDE

Intel IA-32 Red Hat Linux 7.2 linux (32-bit mode) GNOME

DEC ALPHA Digital UNIX 4.0 alpha64
31-2

Installing TCAD Products and Utilities



Table 31-2 lists the version U-2003.09, U-2003.06, and U-2003.03 
TCAD products and their supported platforms. For the latest 
product-specific platform information, see the release notes for your 
tool.

Installing TCAD Products

The general procedure for installing a TCAD product consists of the 
following steps:

1. Obtain a SolvNet account.

2. Download TCAD software or request CD media.

3. Establish a TCAD directory.

4. Run the product installation script.

Table 31-2 TCAD Products and Supported Platforms 

Product Version Platform keyword

Aurora U-2003.09 sparcOS5, hp32, linux, rs6000, alpha64 

Raphael U-2003.09 sparcOS5, sparc64, hp32,  rs6000, alpha64   

Raphael NES1

1. These products might require government-issued export licenses prior to 
sale to certain countries. Contact your sales representative for additional information.

U-2003.03 sparcOS5, hp32,  rs6000

Taurus-Layout U-2003.09 sparcOS5, hp32, rs6000, alpha64 

Taurus-Medici V-2003.12 sparcOS5, hp32, rs6000, linux, alpha64 

Taurus-TSuprem4 V-2003.12 sparcOS5, hp32, rs6000, linux, alpha64 

Taurus-Visual U-2003.09 sparcOS5, hp32, rs6000, alpha64 

Taurus-Workbench U-2003.09 sparcOS5, hp32, rs6000, alpha64 
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5. Obtain the license.dat file and start the license daemon. 

To obtain the license.dat file, go to the SmartKeys Web page at 
http://www.synopsys.com/smartkeys. 

For information on starting the license daemon, go to the 
Licensing QuickStart Guide at www.synopsys.com/keys.

Obtaining a SolvNet Account

SolvNet is the online gateway to Synopsys service and support. 
Through SolvNet, customers can retrieve software, request media, 
retrieve license files, and view online documentation.

If you do not have a SolvNet account, register for an account by 
visiting the SolvNet Web site (http://solvnet.synopsys.com) and 
following the instructions to register with SolvNet.

Note:   
To access Synopsys online services in SolvNet, you need to 
register with a valid Synopsys site ID.
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Downloading TCAD Software or Requesting CD Media

After establishing a SolvNet account by using your Synopsys site ID, 
you can download the TCAD software from the Synopsys electronic 
software transfer (EST) system or, if eligible, request CD media. 

To download the software, follow these steps:

1. Go to ftp.synopsys.com.

% ftp ftp.synopsys.com

2. When prompted for a name and password, enter your SolvNet 
logon name and password.

3. At the ftp prompt, set the transfer mode to binary.

ftp> binary

4. Change directory to the revenue vault.

ftp> cd /rev

5. Change directory to the appropriate product directory (for 
example, a_tcad-medici_version).

ftp> cd product_directory

6. List the directory contents.

ftp> dir

7. For each file that you want, retrieve the file by using the get 
command. 

% get filename

For example,

% get tcad-medici_version_platform.install

8. After retrieving the product files, quit the FTP session.
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ftp> quit

To request CD media,

• Log on to the SolvNet Web site (http://solvnet.synopsys.com) 
and click the MediaDocs link.

Note:   

Because of contract restrictions, only certain sites are 
authorized to order CD media. If you are not sure about your 
site’s eligibility, contact your Synopsys account manager.

Establishing a TCAD Directory Tree

If a TCAD product has previously been installed on your system, a 
TCAD directory with a name such as /usr/tcad should already exist. 
If you are uncertain about the directory name, contact your system 
administrator for assistance.

If a TCAD directory does not exist, decide where to store the TCAD 
products on your system. Consult Table 31-3 to determine the 
approximate disk space required for the products you need. Make 
sure you select a location with sufficient disk space to install these  
products and allow room for future installations.

Table 31-3 TCAD Disk Requirements 

Product Disk (MB)

Aurora 190

Raphael 125

Raphael-NES 75

Taurus-Layout 20
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Running the Installation Script

If you are installing from a file retrieved from the FTP site, make sure 
the file has the correct file permissions:

% chmod 755 product_version_platform_install

If you are installing from CD, mount the CD and change directory to 
the CD drive. Contact your system administrator if you require 
assistance in mounting the CD. 

Next you must run the installation script:

% ./product_version_platform_install 

The installation script creates the appropriate directories and installs 
the product. During execution of the script, several actions take 
place, and some require you to respond to prompts.

1. The installation script prompts you for your TCAD directory.  
Enter the full path to your TCAD directory. The installation script  
then extracts the product into your TCAD directory.

Taurus-Medici 250

Taurus-Tsuprem4 125

Taurus-Visual 125

Taurus-WorkBench 355

Table 31-3 TCAD Disk Requirements (Continued)

Product Disk (MB)
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2. Upon successful completion of the installation, the script displays 
a summary. A copy of this summary, as well as a log of your 
responses to the system prompts, is located in the 
install_program.log file in the program directory.

Caution!   
You must add the tcad/bin directory to your search path if it is not 
already there. For example, if your TCAD directory is
 /usr/tcad, your search path must include /usr/tcad/bin. For 
details, see “Setting Up Your Search Path,” next.

After the installation is completed, the directory tree shown in 
Table 31-4 exists as subdirectories of the TCAD directory.

Table 31-4 TCAD Subdirectories

Subdirectory Contents

bin/ Contains links to the TCAD executable files.

program_version/ Contains the TCAD product files and directories, 
including the install_program product installation 
script.

utility/ Contains various utilities for use with TCAD 
products. For a discussion of the contents of the 
utility directory, see the “TCAD utility Directory” on 
page 31-21. 

license/ Contains the TCAD Network License Software and 
the license.dat license data file.

license_tma/ Contains the TCAD Network License Software for 
all supported platforms in compressed tar format.
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Setting Up Your Search Path

A search path is a list of directory paths. The system searches 
through directories to find an executable file. Each TCAD product 
user must have a search path that contains the TCAD bin directory. 
This section explains how to set up your search path so that you can 
run a TCAD product from any directory.

Checking Your Search Path

If a TCAD product has already been installed on your system with the 
installation script, the TCAD bin directory might already exist in your 
search path. To determine whether it does, enter

% which program

where program is a TCAD executable file such as medici, raphael, or 
taurus.

If you get a response similar to

/usr/tcad/bin/program

your search path is set correctly.

If you get a response similar to

no program in /bin /usr/bin /usr/local/bin

you must modify your search path as described in the following 
section.
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Modifying Your Search Path

Your search path is defined by the PATH environment variable. 
Determine your current search path by entering

% echo $PATH

Note:   
PATH must be entered in uppercase letters.

This is an example of a search path:

.:/bin:/usr/bin:/usr/local/bin

Modifying Your Path in the C shell

The following example illustrates the commands used to modify your 
path. In this example, the TCAD directory on your system is named 
/usr/myaccount/tcad. 

• To permanently add this directory to your search path, add the 
following line to your $HOME/.profile:

set path=(/usr/myaccount/tcad/bin $path)

Save your changes.

• Enter the following command:

% source .cshrc 

Modifying Your Path in the Bourne or Korn Shell

To modify your path you must use specific commands. In this 
example, the TCAD directory on your system is named /usr/
myaccount/tcad. 
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• To permanently add this directory to your search path, add the 
following line to your $HOME/.profile or $HOME/.kshrc file:

PATH=/usr/myaccount/tcad/bin:$PATH
export PATH

Save your changes.

• Enter one of the following commands:

$ . profile 

or

$ . kshrc

Setting the User Environment to Find the TCAD License

When you start a TCAD tool, the tool looks for a license in this order:

• The default location, TCAD directory/license/license.dat

• TMALIC

• LM_LICENSE_FILE

The TMALIC and LM_LICENSE_FILE environment variables point 
to the license server. For example,

setenv LM_LICENSE_FILE /path/to/license.dat
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Running TCAD Products

Table 31-5 lists the general format for most TCAD products. (For 
product availability for this release, see “Supported Platforms and 
Media Availability” on page 31-2.) If you install multiple versions of a 
product, the executable name is whatever you chose during 
installation. For most products, if you run them without specifying an 
input file, you are in interactive mode. 

Table 31-5 Products and Keywords

Product Format Description

Aurora aurora input_filename Runs Aurora with an input file.

Aurora auroragui Runs the Aurora GUI.

Davinci davinci input_filename Runs Davinci (30,000 nodes) with an 
input file.

Davinci dv30k  input_filename Runs Davinci (30,000 nodes) with an 
input file.

Davinci dv60k input_filename Runs Davinci (60,000 nodes) with an 
input file.

Davinci dv100k input_filename Runs Davinci (100,000 nodes) with 
an input file.

Medici medici input_filename Runs Medici (10,000 nodes) with an 
input file.

Medici md3200 input_filename Runs Medici (3,200 nodes) with an 
input file.

Medici md10000 input_filename Runs Medici (10,000 nodes) with an 
input file.

Medici md20000 input_filename Runs Medici (20,000 nodes) with an 
input file.
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Medici md60000 input_filename Runs Medici (60,000 nodes) with an 
input file.

Raphael raphael_program input_filename Runs Raphael with an input file.

Raphael dplot input_filename Runs Dplot with an input file.

Taurus-Device tdevice input_filename

 

Runs Taurus Device with an 

input file.

Taurus-Layout tlayout input_filename Runs Taurus-Layout with an input file.

Taurus-Process tprocess input_filename

 

Runs Taurus Process with an 

input file

Taurus-Visual tv Runs Taurus-Visual.

Taurus- 
WorkBench

twb Runs Taurus-WorkBench.

TSUPREM-4 tsuprem4 input_filename Runs TSUPREM-4 with an input file.

Table 31-5 Products and Keywords (Continued)

Product Format Description
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Using Graphics Devices

This section discusses how graphics devices are described to TCAD 
products and how they are specified with parameters of program 
statements.

Graphics Device Hierarchy

With TSUPREM-4, the graphics device used is determined as 
follows:

• If a graphics device is specified in the input file with the DEVICE 
parameter on the OPTION statement, TSUPREM-4 uses that 
device.

• Otherwise, if the DEFPDEV environment variable is defined, 
TSUPREM-4 uses its value as the graphics device.

• Otherwise, if the TERM environment variable is defined, 
TSUPREM-4 uses its value as the graphics device.

• Otherwise, TSUPREM-4 uses the default device specified in the 
s4pcap file, which is initially set to ps for Postscript. The s4pcap 
file contains a description of each device known to the program. 
You can modify the file to make the default device refer to any 
available real plotting device. The default device specified in the 
s4pcap file is used if neither DEFPDEV nor TERM is defined.

With the other simulators, the graphics device used is determined as 
follows:

• If a graphics device is specified in the input file with the DEVICE 
parameter on the PLOT statement, that device is used.
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• Otherwise, if the DEFPDEV environment variable is defined, its 
value is used as the graphics device.

• Otherwise, the default graphics device is used. The default 
graphics device is defined by the first line in the prpdev file that 
contains an asterisk (*) as the first nonblank character. The
 prpdev file is located in your TCAD directory in 
program_version/platform. 

Note:   

The pr notation in prpdev refers to the product code (md, dv, 
and so on) that you are using. See Table 31-5 on page 31-12.

Specifying a Graphics Device

With TSUPREM-4, you can specify the graphics device in the input 
file with the DEVICE parameter on the OPTION statement. For 
example, the following statement sets the graphics device to X:

OPTION DEVICE=X

If you do not specify a graphics device in the input file, the DEFPDEV 
environment variable is used if it is set. You can set DEFPDEV to 
specify the graphics device by entering the following command: 

% setenv DEFPDEV graphics device

If you are using the Bourne or Korn shell, you can use DEFPDEV to 
specify a graphics device by entering the following command: 

$ DEFPDEV=graphics device
  export DEFPDEV

If you are using the C shell, you can set DEFPDEV so that the X 
graphics device is used by entering the following command:
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% setenv DEFPDEV x

Note:   
The graphics device must be entered in lowercase letters.

By setting the value of the DEFPDEV environment variable, you can 
set the graphics device to any device you want to use without 
disrupting work in progress by other TCAD software users.

With TSUPREM-4, if neither OPTION nor DEFPDEV is specified, 
TSUPREM-4 checks the TERM environment variable. TSUPREM-4 
looks for the graphics device specified by TERM in the s4pcap file. If 
the graphics device is not found, and neither OPTION nor DEFPDEV 
is specified, TSUPREM-4 prints the following messages:

** Plot device vt100 not found in s4pcap file.

** Plotting to default device in s4pcap file.

In the first message, vt100 is the name of the device to which TERM 
is set.

With TSUPREM-4, if OPTION is not used and neither DEFPDEV nor 
TERM is set, TSUPREM-4 uses the default graphics device set in the 
s4pcap file. By default, the graphics device is set to ps in the s4pcap 
file. 

With most other simulators, you can specify the graphics device in 
the input file with the DEVICE parameter on the PLOT statement. For 
example, the following statement sets the graphics device to X:

PLOT.2D TITLE="EXAMPLE" DEVICE=X

With the other TCAD simulators, if the PLOT statement does not 
specify a graphics device and DEFPDEV is not set, the simulator uses 
the default graphics device. The default graphics device is defined by 
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the first line in the prpdev file that contains an asterisk (*) as the first 
nonblank character. (The prpdev file is located in your TCAD 
directory in program_version/library.)

For example, if you want to change the default graphics device from 
Sun to X, edit the prpdev file and move the asterisk (*) from the Sun 
entry to the X entry.

Before modification:

*SUN       29  20.32  15.24   33.0   33.0  -1  F  F  FTFF 9999
 I/SUN     29  20.32  15.24   33.0   33.0  -1  F  F  FTFT 9999
 X         30  20.32  15.24  500.0  500.0  -1  F  F  FTFF 9999

After modification:

SUN       29  20.32  15.24   33.0   33.0  -1  F  F  FTFF 9999
I/SUN     29  20.32  15.24   33.0   33.0  -1  F  F  FTFT 9999
*X         30  20.32  15.24  500.0  500.0  -1  F  F  FTFF 9999

For further information on the prpdev file and possible graphics 
devices, see the manual for the TCAD product you are installing. 
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Sun, X, and tmaplot

Both Sun and X drivers use the tmaplot graphics utility to generate 
graphics by piping graphics output through the tmaplotx executable 
program. The tmaplot utility automatically remembers up to 200 plots 
and allows you to scroll through them.

Use the following means to control the display:

• Right mouse button: Scroll backward

• Left mouse button: Scroll forward

• Control-c: Kill tmaplot display

To use X graphics, you must set the DISPLAY environment variable 
to your display machine. Usually, DISPLAY is set to the name of your 
computer followed by :0.0. For example, if the name of your machine 
is mymachine, enter the following command to set DISPLAY:

% setenv DISPLAY mymachine:0.0

Note:   
To Sun users—You must also set the LD_LIBRARY_PATH 
environment variable to your OpenWindows library directory. For 
example,

% setenv LD_LIBRARY_PATH /usr/openwin/lib
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Troubleshooting

Error Message:

Xlib:  connection to "machine:0.0" refused by server
Xlib:  Client is not authorized to connect to Server
Bad return from XOpenDisplay

Explanation:

The program does not have permission to open a window on the 
display.

• Check to be sure the DISPLAY environment variable is set 
correctly.

• If the DISPLAY environment variable is set correctly on the 
console of the display, enter the following command:

% xhost +

Error Message:

tmafork: command not found

Explanation:

The tmafork TCAD utility cannot be found.

• Check to be sure the TCAD bin directory is in the search path.

• Check to be sure the TCAD utilities are installed correctly and 
that tmafork is linked to the TCAD bin directory.

Error Message:

*** Open Pipe = signal 13 code 0
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Explanation:

The TCADPLOT process is terminating abnormally, leaving the 
TCAD program piping data to a broken pipe.

• Check to be sure TCADPLOT works correctly outside the TCAD 
program by entering the following command:

% tmaplot x test

• If TCADPLOT works correctly outside the TCAD program, the 
error is most likely caused by insufficient system resources to 
start the TCADPLOT process. Check your system resources 
when running the TCAD program to be sure there are enough 
resources to run the TCADPLOT process.

Error Message:

window: Base frame not passed parent window in environment
Cannot create base frame. Process aborted.

Explanation:

You are attempting to run a SunView application when you are not 
running in the SunView window environment. This error can occur 
during STUDIO if your path is not set correctly.

• If you are running OpenWindows, be sure the OpenWindows bin 
directory precedes the /bin and /usr/bin directories.
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TCAD Utilities

The TCAD utilities are a set of programs designed to help you use 
TCAD products more effectively. TCAD utilities are installed   
automatically as part of a TCAD product installation.

TCAD utility Directory

The utility directory for all new releases of TCAD products (after June 
1991) is product independent. The utility directory contains a file 
named V#.# (where # is a number). V#.# is the version number of the 
utility in that directory. 

Table 31-6 lists the utilities that TCAD provides.

Table 31-6 TCAD Utilities

Utility Description

tmaplot Generates Sun (SunView) and X graphics. For 
products released after June 1991, you must use 
tmaplot if you use Sun or X graphics.

tmafork Allows systems that do not have a vfork system 
call to run a TCAD product without temporarily 
doubling the virtual memory required.

replot Allows you to re-create TCAD graphical output 
without rerunning a simulation.

rfbtoa Takes a TCAD binary output file, such as a 
structure file, and converts it to ASCII format.

tfatob Takes a TCAD formatted (ASCII) file and 
converts it to binary format.
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The tfatoa and tfbtob utilities are useful if you have TCAD products 
on multiple machine types. A binary file can be transferred between 
machines by converting it to ASCII on one machine and then 
transferring it to the second machine. Then it can be converted back 
to binary on the second machine.

Following is the directory structure of the utility directory, as it exists 
in a standard installed TCAD directory tree. The directories are 
shown with a trailing slash.

TCAD directory/bin/TCAD product/utility/
V#.#
install_utility

replot/
replot
replotx
rppdev
rperr0
tfatob/
tfatob
tfatovx
tfbtoa
tfbtoax
tferr0
tmafork/
tmafork
tmaplot/
tmaplot
tmaplotx
tfbtoa
tfbtoax
tferr0

Note:   
The TCAD utilities do not require licenses. You can use them on 
any machine under the direct control of your organization. 
However, you are not allowed to copy or distribute the TCAD 
utilities elsewhere.
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Executing the TCAD Utilities

To execute the TCAD utilities, you must include the tcad/bin directory 
in your search paths, as described in “Setting Up Your Search Path” 
on page 31-9. 

If you install updates to the TCAD utilities in the future, the 
installation script creates links from the new version of the TCAD 
utilities to the tcad/bin directory. Therefore once the search path has 
been modified to include tcad/bin, it is already set up for updates.
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A
Installing VirSim (version 4.3) A

This appendix contains the following sections that give instructions 
for installing the stand-alone VirSim GUI:

• Installing the Software

• Setting Up VirSim for Each User

• Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
Environment Variable

• Verifying the VirSim Installation

• Customer Support

Important:   
The stand-alone installation instructions in this chapter apply 
only to customers who do not have the VCS or VHDL Simulation 
(Scirocco) tools. VirSim installs automatically with those tools.
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Installing the Software

To download and install VirSim from the Web or by FTP, e-mail 
virsimsupport@synopsys.com. 

Table A-1 shows the supported platforms for the 7.1 release.

To download and install VirSim,

1. Create a VirSim installation directory and change to that 
directory. For example,

% mkdir virsim_install_dir
% cd virsim_install_dir

2. Download the software to the installation directory.

3. Uncompress and untar the files:

% gzip -dc virsim_platform_version.tar.gz | tar xvf -

Table A-1 Supported Platforms and Keywords

Operating system Platform keyword

Solaris 7, 8 sparcOS5  (32-bit platform)
sparc64      (64-bit platform)

HP-UX 11.0, 11i hp32
hp64

Red Hat Linux 7.2 linux for Intel (2.4 kernel)
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Setting Up VirSim for Each User

To set up a new VirSim tool user, add the VirSim directory containing 
the executable file to the PATH environment variable.

1. Set the VIRSIMHOME environment variable to point to the 
installation directory. For example,

If you are using the C shell, enter

% setenv VIRSIMHOME virsim_install_dir 

If you are using the Bourne, Korn, or Bash shell, enter

% VIRSIMHOME=virsim_install_dir 
  export VIRSIMHOME

2. Update your PATH environment variable as follows:

If you are using the C shell, enter

set path=($VIRSIMHOME/bin $path)

If you are using the Bourne, Korn, or Bash shell, enter

PATH=$VIRSIMHOME/bin:$PATH
export PATH
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Setting the SNPSLMD_LICENSE_FILE or 
LM_LICENSE_FILE Environment Variable

To enable VirSim to check out a license, you must
set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE 
environment variable as follows: 

• If you are using the C shell, add the following line:

setenv SNPSLMD_LICENSE_FILE port@hostname

• If you are using the Bourne, Korn, or Bash shell, enter these 
lines:

SNPSLMD_LICENSE_FILE=port@hostname
export SNPSLMD_LICENSE_FILE

The port and host name variables correspond to the TCP port and 
license server host name specified in the SERVER line of the 
Synopsys license file. To ensure better performance, it is 
recommended that you use the port@host name rather than using 
the path to the license file.
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Verifying the VirSim Installation

To verify the VirSim installation,

1. Change directories to an examples directory.

% cd $VIRSIMHOME/examples/verilog/risc

2. To invoke VirSim, enter

% virsim +vpdfile+risc.vpd +cfgfile+risc.cfg -f run.f

3. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

The support page on the Synopsys Web site is regularly updated 
with the latest information. Check this page for application notes, 
online help updates, and other valuable information:

http://www.synopsys.com/products/simulation/simulation.html

You can also send an e-mail message to VirSim Support at 
virsimsupport@synopsys.com.
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